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[0] Document revision

Document Notes

V1.0 (USCO.EI.RF0.A1.22 / 521U0102) First document release 

VC02_101 (USCO.EI.RF0.B2.22 / 
521U0113)

New items added:
New RMT FTP screen, Copy / Paste feature, Global Upload / Download, Web Advance View, Po 
Optimization,  Updating system software via USB and DIN unit.  New Variable output configuration & I/O 
module added.  EDF device list added

VC02_103 (USCO.EI.RF0.B3.22 / 521U0143) New items added
Controller parameter Import feature
Extended configuration, allowing the user to change the parameter used in overview screen
New EKC controllers added to support list
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[1] Product Introduction
Your Application
The Danfoss AK-CS ‘front end’ controller is a modern solution for the C-Store & Small sized markets.  The AK-CS uses the latest technol-
ogy to  provide the maximum benefit to the end user, both in terms of energy saving optimization, control options and user friendly 
access.  Designed specifically with the C-Store & Small applications in mind, the AK-CS provides all the functionality and tools to provide 
full application ‘coverage’, from Refrigeration, HVAC, Store lighting to Demand limiting.
The Danfoss AK-CS represents the most flexible answer to today’s demands & balances cost effective control, continuous energy 
optimization and long term flexibility via miscellaneous inputs and boolean logic commands, all built in to one easy to use front end 
controller.

Modern Technology at work for you
Modern tools like the built-in USB flash drive port allows for easy firmware updating & saving of the database.  All part of the AK-CS 
package is the Remote Management Tool, a simple & free application that allows remote updates, software management & the saving 
of databases on the AK-CS.  Full remote access is powered by the AK-CS built in web server, providing you with an advanced web 
browser environment in which to control, view & monitor all your important assets.
Headline features as a glance:

AK-CS Headline Features Benefits

Built in Compressor, Condenser, Circuit control Control already built in - Reduce complexity & cost 

Built in or controller stat HVAC control Up to 10 HVAC units adding to close control and energy savings

Condenser, Circuit control via Danfoss controls Full support of market leading Refrigeration controls from Danfoss 

25 Schedules Groups (with 8 schedules per group) Central Defrost, Case lighting, Store / Outside Lighting, Night setback, Shutdown

Flexible Alarm Routing / Output Ability to e-mail, IP address, multiple relay, modem, print alarms

Built in Modbus, LonWorks® network More scope for control solutions - Established protocols

Full color VGA Local screen view & access Access all areas of your system from easy to use local screen

Built in Buzzer & 2-tone LED Easy local level alarm notification

Support for Danfoss AK I/O modules I/O module support offering extended and flexible  control, monitoring

Simple Site View image - Ability to load custom graphic & map 
parameters on local screen

Create simple & clear graphic screen with only ‘key parameters’ shown - simply 
the management of your services

600 History points Large history storage capacity to ensure HACCP compliance & service level detail

Multiple users / user levels Definable user list with clear authorization levels

Multiple language support Local & Browser language support

USB flash drive support Reduce commissioning time & Cost

Full web browser access Standard web browser connection provides access to all areas of the system

Built in Boolean Logic commands Create your own logic to control even the most obscure application

Remote Management Tool Remotely manage your system - Update software, save database, load images
VizEdit tool( built-in to RMT) allowing custom image & mapping of parameters

Ordering Description

080Z2550 AK-CS (LONWORKS® TP78 SCREEN)

080Z2552 AK-CS (LONWORKS® TP78 DIN)

080Z2551 AK-CS (LONWORKS® RS485 SCREEN)

080Z2553 AK-CS (LONWORKS® RS485 DIN)

ORDERING
Contact your local Danfoss sales office 
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Product Introduction

Application areas
The illustrative diagram below highlights why the AK-CS is such a powerful tool, bringing together your services and control needs.  
Under one control point improved plant energy efficiency, managed settings and schedules are possible.  Acting as the central 
‘commander’ in the network, the AK-CS can ensure correct start/stop times of the refrigeration and HVAC assets,  switch the car parking 
lights on only when light levels drop to a defined level, monitor energy usage & even switch off HVAC units if consumptions reaches a 
defined level.  Need to monitor the gas tanks levels, oven status or soft drinks dispenser?  Using the custom monitoring functionality it’s 
all possible.

HVAC Control & Monitor

Refrigeration control 
(built in compressor control) 

Lighting Control & Monitoring

Refrigeration control 
(Support for Danfoss controllers) 

APPLICATION SOLUTIONS

Custom Control 
(Sensor, On/Off, Relay, Misc) 

Built-in Web server 
RMT tool for remote file managementXML Built-in XML for enterprise interface 
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[2] Installation 

10.16” (258 mm) 

20.34” (516.34 mm) 

Mounting 
The mounting location should be flat, dry and free from major vibrations.  The AK-CS should be mounted at eye level, with consideration 
for the following approximate outline dimensions: 
Unit Width 10.5” (266 mm) 
Unit Height 12.5” (317 mm) 
Unit Depth 2.5” (63 mm)  
- Mounting holes 8.0” (203.2 mm) Width 
- Mounting holes 10.00” (254 mm) Height

To allow the AK-CS door to fully open, ensure that there is an area at least 21” (533 mm) x 11” (280 mm) free, leaving room for conduit 
connections beneath the controller if required.  Mount the controller using appropriate screws through the available holes.   

Internal component layout 
With the controller door open, the two main sections of the AK-CS can be seen:  Base board & Connector board.
- Base board -
Mounted on the door frame is the ‘Base board’ with the main CPU card. The base board contains the battery (shipped in disabled posi-
tion) Type CR2032 with (+) side facing toward the user.  This battery must be engaged in order to protect any configuration settings 
during power loss. 

Door opening clearance

Engage battery circuit to ensure data is protected after power loss - Failure to energize battery will risk any installed 		
system configuration to be erased upon unit power loss.  Pins 1 and 2 must be linked to enable battery.		
WARNING - The AK-CS contains a 3 V battery (type CR2032) to maintain programmed		
settings.  Do not recharge, disassemble or dispose of in fire.  Danger of burn or explosion may 
occur if mistreated, follow local regulations for correct disposal.  

WARNING: To avoid risk of injury from electric shock, ensure correct electrical isolation is made 
before working within the enclosure.

3    2    1 
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H Jumper 5 (Pins 1 & 2 must be linked to enable battery)

I CR 2032 Battery (+ facing up)

J AK-CS CPU card (MAC address shown on label)

K USB Flash drive port

L AK-CS Reset button

AK-CS  Base Board

DIN Version
The AK-CS is also offered in DIN mount.  To assist in the initial configuration use the rotary address switch to assign a fixed 
IP address (position 9 = 192.168.1.161).   

A Ethernet Port

B Modem Port (alarm dial out)

C Alarm Relay (TP 78 model only)

D RS485 Modbus Port (SLV compressors, EKC, Carlo gavazzi)

E Lonworks® TP78 or RS485 (note RS485 model has x1 port)

F 1.0 Amp, 250V Slow Blow Fuse

G Power (100-240V a.c. 50-60Hz)

Connector board - AK-CS

Alarm relay, Lonworks® I/O network

USB, Ethernet, RS232 & 
Modem (alarm dial out)

Modbus port, address switch
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AK-CS RS485 version
This example shows the AK-CS RS485 version.  Both screen and DIN models have a single 
RS485 communication port.  The RS485 network protocol must be wired in a ‘daisy chain’ 
format.  Recommended that polarity is maintained.

AK-CS RS485 version (mid network 
connection)

This example shows the AK-CS RS485 version 
used in the middle of a network run.  In 
this example ensure that both ends of the 
controller run are fitted with 120 Ohm 
terminators.

Terminator 
(120 Ohm)

Terminator 
(120 Ohm)

Last device 
Terminator 
(120 Ohm)

Terminator 
(120 Ohm)

xxx

For Modbus controllers, use the RS485 port and wire in daisy chain format (as 
RS485 example above).  Note that Danfoss Modbus controls cannot be mixed with 
Carlo Gavazzi power meter, due to incompatible baud rates.

AK-CS TP78 version
This example shows the AK-CS TP 78 version .  The TP 78 screen version has 5 network ports, 
whereas the AK-CS DIN version has 3 TP 78 network ports.  The TP 78 network protocol must 
be wired in a ‘daisy chain’ format and is not polarity sensitive.

        Danfoss recommends the following wiring standard to ensure reliable communications to	
        network devices: 
	 UL Listed & rated type CMP (Plenum rated), Single pair shielded Echelon compliant 	
	 cable.  Windy City Wire #106500-S  22 gauge, stranded, blue jacket

Terminator 
(120 Ohm)
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[3] Remote Management Tool (RMT)
The Remote Management Tool (RMT) is a complementary PC software application tool that allows various remote management tasks 
to be performed on the AK-CS.  The RMT offers the following features;

VizEdit -		L oad custom store (bit map) graphic & map system data points to this image
			R   emotely load image file to local AK-CS screen & web browser
FTP - 		R  emotely connect, load and access system files
			R   etrieve datapoints
Address Book - 	S ave your most commonly connected site details to allow for one click connection
Tools-		  Download System software, backup (save) & load database file.
Language-	C ompatible in multi- languages 

Retrieve datapoints (Any configured sensor, controllers, points will be seen in the drop down list

FTP (access & manage system files) 
Menu Bar

Translator (Translate RMT screens to ensure language compatibility)

Installing the Danfoss RMT package

The RMT is a complementary application tool that allows various remote management tasks to be performed.  The RMT tool requires 
minimum a PC running Windows® XP or Vista with a minimum of Intel® Pentium® III 1GHz or faster processor, 512MB of RAM.  

The following steps should be taken to install the RMT tool

VizEdit (manage your custom site graphic, map system parameters )

Language
Select required language 
(translation is done under the 
Translator tab)

Custom (bmp) Image
Design your graphic in your 
favourite image processing 
software and save as bitmap.  
Use the Viz tool to then load & 
map parameters

1

2

3

RMT requires Adobe AIR™ environment.  Download and install the free Adobe AIR™ application (www.adobe.com/products/air) 

Load the Danfoss RMT application (available from your local Danfoss Sales office) 

Run the RMT application on your PC and check for correct installation
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Required IP ports

As the AK-CS uses IP networking standards to create remote access  it may be necessary to configure any site routers to allow incoming 
connections, either from a LAN or WAN view.  The figure below shows a simple IP connection with the AK-CS connected to a standard 
network router with a typical factory IP address range.  From within the LAN any remote connections should ‘point’ to the master IP 
address of the AK-CS, in this example http://192.168.1.100.  If however the remote connection is on a WAN then the LAN router may 
need to be configured to allow this inbound connection, with the addition of the web port added tot he end of the http sting.

Please refer to the port allocation table below  for remote IP connections

IP Port Use Notes
- LAN side -

80 web browser This port is user configurable but factory set to 80

21 RMT tool This port is user configurable but factory set to 21

- WAN side -

1024-4096 RMT tool - Site View configuration / modification This port range are required to be opened if WAN remote 
configuration is required on the Site View page using the 
RMT tool 

Notes for FTP port forwarding in AK-SC255 units
In AK-CS units, FTP service is a convenient way to download/upload files and updating database/code. However, the AK-CS FTP functions 
under 'passive' mode (which is a safer mode on the network), therefore ports 1024 to 4096 should be forwarded from the router to the 
AK-CS unit if FTP access via WAN is used.  This operation allows a wide range of port forwarding and may cause the other devices using 
the same port for WAN access issues.  Open FTP server ports to the public internet is not considered as a safe network practice.  To 
avoid these issues, Danfoss strongly suggests FTP functionality in LAN network only .  This would reduce the risk of open FTP ports 
and enhance network security.   

LAN Network Router
IP 192.168.1.1

LAN Network Router
WAN IP 172.28.6.108

For WAN access port 
forwarding is required

Master IP 192.168.1.100
Default Gateway 192.168.1.1
Network Mask 255.255.255.0
(AK-CS factory set http port = 80)

Computer A
type ‘http://192.168.1.100’ to access AK-CS

Computer B
type ‘http://172.28.6.108 to access AK-CS

1. The port number is required to be typed 
into the URL address ONLY if the web port is 
NOT configured as 80.  For example, if the port 
number is configured as 8080, then Computer 
A needs to type in http://192.168.1.100:8080, 
while Computer B needs to type in 
http://172.68.6.108:8080 to access the website 
of the unit. 

2. If the port number is defined as default 
number 80, then it is not necessary to type in 
“:80” in the URL address, this is because the 
HTTP protocol uses 80 as default port. If  the 
router port forwarding is correctly configured, 
it is not required in WAN access either.

Port allocation table
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Using the VizEdit tool

The VizEdit section of the RMT allows for a custom bit map graphic to be used in the local AK-CS screen & (Jpeg) web browser.  In 
addition to a graphical image, system parameters can be mapped to display current temperatures & staus.  This may serve as a simple 
screen to identify current temperatures of your application.  If no graphic is loaded in the AK-CS a factory logo will be seen in the 
system view screen.

Use a suitable image processing application to design your custom image should be used, complying with the following specifications;
632x408 pixels•	
8 bit•	
256 or less colors•	
Bit Map format (used for AK-CS Site View screen)•	
Jpeg format (used for AK-CS browser)•	

The following example highlights the steps required to load and map system parameters to a custom graphic - the result will be seen in 
the AK-CS local screen (Site View) and browser connection.  In order to map system parameters to the graphic, ensure the AK-CS has all 
the configuration settings and control options set.  Only configured points will be seen in the RMT tool when retrieving datapoints.

1/ Create a custom graphic
Using the precise file size mentioned above (632x408, 8 bit, 256 colours) create a graphic that will be seen in the local AK-CS screen.  
When designing the graphic, consider that sufficient space is required to map system parameters.  For best results, a clean simple 
image works best with space for mapped parameters. 

2/ Save the graphic
Upon completion of the graphic, save the image in both bit map and Jpeg format (two separate files).  The Bit map file will be used for 
the AK-CS and the Jpeg is used for the remote browser connection.  Both files are saved in the AK-CS.

3/ Open graphic in RMT tool
Start the RMT software and navigate to the File menu.  Select File, New (File->New), navigate to the saved bit map image and click 
Open.  Under the VizEdit tab your image should now be displayed.  Any errors in loading the image typically indicates that incorrect file 
attributes have been used - check pixel size, colour.

4/ Retrieve Datapoints from (connected) AK-CS
Click on the Retrieve Datapoints button - a dialogue box will open asking for the IP address of the AK-CS.  Click the OK button and a 
progress bar will indicate the datapoints (system parameters) being uploaded to the RMT.  After successful upload, the datapoints will 
be seen in the left hand screen of the RMT.  Navigate through the collapsible headings to view all the datapoints.

5/ Adding datapoints to the graphic
Simply drag and drop the required datapoint(s) to the graphic - click and hold the datapoint and move to desired location on the 
graphic.  Follow this principle for any remaining points.  Tip! Use the PC arrow keys to ‘fine tune’ parameter positioning.

View the datapoints that were uploaded 
to the RMT.  Navigate, drag & drop to 
graphic as required

Under the menu Data select Preferences to 
assist in the drag/drop function.  A grid is 
available to assist in the positioning of the 
datapoints on the graphic.

Double click any datapoint on the graphic to 
open a settings box.  
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6/ Saving the graphic and mapped datapoints
After completing the mapping of required parameters the graphic must be saved in a format that the AK-CS will use to display in the 
local screen.  The graphic must now be saved as a Viz (visual) file.  Click the Save As... selection under the file menu - type a name for the 
file, followed by the .viz file extension.  For example the following file name would be acceptable - ‘akcsgraphic.viz’

7/ Downloading the Viz file graphic to the AK-CS
To download the graphic (including the Jpeg version) the user must be authorized.  Click on the Log On button to log in to the AK-CS.  
The log on dialogue box will show the AK-CS (host) IP address, user name and password.  The factory set user name is Supervisor and 
the password is 12345.  Click on the ‘Download to AK-CS Unit’ button.  The following dialogue box will appear;

IP address = IP address of connected AK-CS
User Name = akcs
Password = danfoss

Navigate & locate saved (viz) file
Navigate & locate saved (Jpeg) file

The Jpeg version of the graphic must also have 
the same file size

8/ Observe progress of  file transfer
After clicking the OK button the download will commence.  Observe the progress at the bottom of the RMT tool.  Upon correct 
download a message will appear informing of successful transfer,

Clicking on the Site View key on the AK-CS will now reveal the graphic.  Any mapped parameters will automatically update and refresh.

The downloaded graphic can now be seen in the Site View screen



AK-CS				    User Guide 

13Lit. no. USCO.EI.RF0.B3.22 / 521U0143

Using the FTP tool

Built in to the RMT tool is an FTP service.  FTP (File Transfer Protocol) is a file transfer protocol for exchanging and manipulating files over 
a TCP computer network.  FTP is used when updating files (HTML / EDF) to the AK-CS.  The following description highlights the steps in 
using the FTP tool.

Address Book (Select an IP address from the address book) 
or enter a valid IP address

Directory of AK-CS

FTP Connect / Disconnect on 
AK-CS

FTP Port = 21 (factory standard)
 		           but user selectable)

Local PC directory

Status / transfer progress window

1/ Locate files to be sent to AK-CS
First, locate the files that require sending to the AK-CS - These should be located on the PC.  Use the tree structure in the left hand 
window to navigate to the required files on the PC.

2/ Connect to the AK-CS
Use the ‘Connect ’ button to access the FTP server in the AK-CS - Ensure the correct log in credentials are used.  Correct connection will 
display the AK-CS directory in the right hand window.

3/ Transfer files
Make sure the correct AK-CS directory folder is opened up before sending downloading files.  Use the --> button to transfer files from 
the PC to the AK-CS.  The example below shows the files from the PC (highlighted in blue) ready to be sent to the AK-CS directory.

The relevant directory folder is opened, so that 
the files from the PC can be sent.

-->  to download files from PC to AK-CS

<-- to upload files from the AK-CS to PC

After updating any EDF files or csdevice list the 
AK-CS unit will require a re-set.

User Name = akcs
(lower case)

Password = danfoss
(lower case)

Web server Port = 80 (factory standard)
but user selectable)
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Once the file transfer process is underway, a progress bar will appear indicating the remaining files.

Updating AK-CS software
The function of remotely updating the AK-CS with new software (firmware) is possible using the RMT.  The following steps should be 
observed in order to correctly update the AK-CS

1

2

Log on to AK-CS.  Note that after successful log on the Log on button then reflects the log off function

From the tools menu select ‘Download Application Code (.csi file)’
A dialogue box will appear prompting for the location of the new (.csi) software file.  Navigate to the correct file and click OK.  This 
will load the software in the AK-CS memory, step 3 will then overwrite the original code, thus updating the AK-CS.

User Name = Supervisor
Password = danfoss

Depending on the speed of the IP connection this file 
load may take some time.  During this transfer the AK-CS 
continues to operate normally.
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3 After successful file transfer a dialogue box will ask to overwrite the application code.  Select Yes to update the AK-CS.  A second 
dialogue box appears asking for confirmation as to what .csi file to overwrite (typically there will only be one).  Once Yes is selected 
a progress bar shows the new software being updated. 

The AK-CS will display a message (loading application code) at the bottom of the screen that reflects the update process.  The final 
stage is to reset the unit.  This is done by pressing the OK button in the final dialogue box.  The AK-CS will reset running with the 
newly loaded software.

Ensure that the AK-CS remains connected and is not interrupted with power loss.  Failure to do 
so may corrupt the installation of database and software.

Save / Load AK-CS database
All the values and commissioning settings are held in the AK-CS database.  As a means of backup it is possible to remotely save this 
database using RMT.  The following example highlights the process to remotely save an AK-CS database.

1/ Log on to AK-CS and navigate to the Tools menu.  Select ‘Save Database to PC (Upload)’   

2/ Making sure the User Name and Password are correctly assigned.  Enter a name for the saved database file (the file extension .s55 
must be used).  Enter a description for the file, this (description) will be displayed when  later downloading a database file.  Point the 
RMT to the location on the PC where the file will be saved and click the OK button.

3/ The database will now be saved on the PC. 

4/ Use the ‘Load Database to AK-CS (Download)’ function (located under the Tools menu) to subsequently load any database.

If upgrading AK-CS software on site, consider the use of the USB flash drive option.  Software can be loaded 
via the USB drive & is typically faster in loading.  Consult section [18] for more details.

Point to the (PC) directory which the file will be 
saved to

Enter a file name, followed by the .s55 extension
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Translator
The RMT has a built in translation tool, designed to reflect the correct language in the system tabs and menus seen in the RMT.  The 
changes made in the RMT will subsequently get downloaded to the AK-CS.

Select the chosen language to translate

After translation and saving, the language file (frermt.xml for example) is saved under the HTML directory of the AK-CS.  Each time a 
user connects to the AK-CS the translated file will allow the user to see the custom language in the RMT.

Enter the translated text

Once translation is complete 
save to unit

Ensure that after translation is complete, click the ‘Save to unit button’ before changing 
another language - if the translation is not saved first, all translation will be lost if selecting a 
new language from the drop down list.

Address Book
RMT has a built in address book, that can contain a list of AK-CS (IP) address and log in credentials.  Open the address book by navigat-
ing to the File menu and then Address Book...
Enter the AK-CS details and click the save button.

An easy way to use any address detail is seen under the FTP tab.  Next to the Host IP address entry box a button allows for the selection 
of any entry in the address book. 
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Time, Control, System, Comm, Alarms, History, Network Nodes[1] Configuration

Node Overview, Points, Scan Status, Config Status, Duplicates, 
global Upload / Download

[2] Network Nodes

Access to Miscellaneous Calculations[3] Calculations

Internet Files, Device Files, Device management[4] File Management

View user actions recorded by the AK-CS[5] Audit Trail

Mac address, Software version, website version, IP address[6] Information

Access to connected flash drive[7] Flash Drive

Create / View messages & contact lists[8] Messages

Log out from AK-CS[9] Log Out

Main Menu

Local Screen - Main Menu

After successful authorization, pressing the Menu button on the local keypad will present a selection menu.  From this main menu all 
areas of the AK-CS can be accessed.  The menu has 9 main areas, each with a particular function or group of functions.  The Main Menu 
structure can be seen below.

Factory authorization code
Supervisor
12345
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[4] Configuration
The first selection [1] from the main menu is the Configuration area.  Using the keypad directional arrow keys, navigate to the required 
screen line / tab and press ‘Enter’ to change settings.  This area of the system allows for the following settings;

Configuration ->Time
Set the system date & time
Time Zone - example - set 0 for GMT (this also ensures any alarms sent via e-mail have the correct time zone shown)
Opening Hours - Set the weekly open & close hours.  These times can be subsequently referenced by store lighting schedules (known as 
relative).  I.E. if a lighting schedule is set for ‘relative’ it (schedule) will reference the store open times  
Daylight Savings - Set appropriate month/date/week/time when the system clock should update to daylight savings
Holidays - Set the number of holidays (max 8) - Use this function to define different store open / close times

CENTRAL CONFIGURATION
Configuration -> Control
Control - The central page that defines what systems/sensors are to be used.  The AK-CS has the ability to control either via Danfoss 
controllers or via built in control logic & AK I/O modules.  Use this page to define the store set up.  Each control heading (Refrigeration, 
HVAC, Lighting, Energy, Leak, Misc) is shown - select each control group as required and enter the required quantity / type of control

Each control area is available. 
Navigate to the corresponding 
control question and press 
‘enter’ to assign the required 
number. 

The screen will then expand to 
reveal further control ques-
tions 

Control question

Press the Menu button
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Configuration -> Control
Refrigeration
The AK-CS has the ability to control refrigeration via built in logic or via Danfoss controllers.  Once the initial definition of Refrigeration is 
complete, configuration is done under the Refrigeration tab.

Dewpoint
When answering the question ‘Number of Compressors’ the AK-CS will make available more refrigeration control lines. 
Using the screen example below, when the compressor has a quantity set (in this example, 1) by default the Dewpoint method is 
shown.  The Dewpoint method is used in conjunction with the Antisweat (Railheat) control option.  The Dewpoint method can either be 
‘Calculated’ or ‘Actual dewpoint’.  The calculated dewpoint is derived from a humidity and temperature sensor (which is selected in a 
following question line), if selected, the actual dewpoint can be used.  When using either a humidity or dewpoint sensor the AK-CS will 
build input points so that further in the system these can be defined in terms of their Board & Point location.  

Compressor
The Compressor line now shows the text ‘AK-CS’.  This indicates that the AK-CS will itself control the compressor, this is done via internal 
control logic in the AK-CS and relevant output via AK I/O modules.  If ‘AK-CS’ is selected as the compressor control option, the system 
will automatically create the control questions and Board & Point locations.  These can be seen under the Refrigeration tab.  Details on 
how to configure the compressor using the AK-CS method can be found further in this guide.

Condenser
The Condenser type is shown here as ‘Air Cooled’ but the factory setting is ‘None’.  If the condenser is to be controlled via the AK-CS 
then ensure this selection shows ‘Air Cooled’.  As in the compressor definition, if ‘Air Cooled’ is selected the system will automatically 
create the control questions and Board & Point locations.  These can be seen under the Refrigeration tab / Condenser.

Circuits
The number of circuits in this example has been defined as 4.  The AK-CS has the ability to control circuits either via internal control 
logic or via Danfoss controllers in the form of EKC case controllers.  The AK-CS will automatically label each circuit as ‘Circuit 1a, 1b, 1c, 
etc.  This factory name can be changed under the Refrigeration tab.  The example below shows a mixture of AK-CS and Danfoss control.  
Where the AK-CS will control the circuit the selection will be ‘AK-CS’.  If Danfoss case controllers are used they are selected via a drop 
down box (press the enter key to raise this selection box) & subsequently shown as the controller type.   Seen in the example below, the 
Danfoss EKC 202x range have been selected as case controllers, with Circuit 1d defined as built in AK-CS control.

Number of suction groups required.

If using Danfoss circuit (case) controllers, select the 
appropriate device from the drop down list

Select AK-CS for circuit control by the AK-CS 
built-in logic and AK I/O

If you wish only scanned devices to be shown in the control selection list, select ‘Yes’.  Only 
devices seen by the AK-CS during a network scan will be shown - a new rescan is required after 
changing this setting

Define compressor control (if required), if no compressor 
is defined, custom description text can be added under 
name
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Configuration -> Control
HVAC
The AK-CS has the ability to control HVAC via built in logic or via 2nd Party Distech™ controllers.  Once the initial definition of HVAC is 
complete, configuration is done under the HVAC tab.

When answering the question ‘Number of HVAC units’ the AK-CS will make available more HVAC control lines.  Using the screen 
example below, when HVAC has a quantity set (in this example, 1) other HVAC control lines are made available.

Phase Loss Monitor
The AK-CS can monitor Phase Loss via dry contacts from a phase loss monitor (if installed).  The dry contacts would be inputs to AK I/O 
modules.  The shut down of the HVAC system(s) would then be possible if phase loss was detected.  This would be configured under the 
HVAC tab.

Humidity Sensors
Enter the number of humidity sensors required.  

Unit
As seen in the Refrigeration control, the AK-CS can be configured to control the HVAC via built in control logic or via specific HVAC 
digital thermostats (Distech EC-Stat™). 
To define the control type, navigate to the Unit 1 line (this default name can be later changed under the HVAC tab).  By pressing the 
enter key the choice of built in control (AK-CS) or Distech™ digital thermostat can be seen.  Choose the appropriate Distech™ controller 
via the drop down list or select AK-CS as required.  If AK-CS is chosen for HVAC control the system will automatically build control logic 
under the HVAC tab.  In the example below, the Distech™ RT2 thermostat has been selected, this offers remote communication 
(LonWorks® FTT10) and allows the AK-CS to access many of the parameters found in the EC-Stat™ controller.

Select either built in 
control or communication 
control via Distech 
EC-Stat™

Define quantity of  HVAC 
units 
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Configuration -> Control
Lighting 
The AK-CS has the ability to control interior and exterior lighting (store, car lot, etc) via AK I/O, Danfoss Photocells & built-in schedules.  
Once the initial definition of Lighting is complete, configuration is done under the Lighting tab.

When answering the question ‘Number of Lighting Zones’ the AK-CS will make available more Lighting control lines.  Using the screen 
example below, two lighting zones have been defined, with resulting lines referencing Photocell use.

Zones share indoor photocell
If selected ‘yes’ the AK-CS will allow the sharing of a photocell, saving on equipment cost.

Number of Photocells
Define the amount of photocell required

Define quantity of  Lighting 
Zones
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Configuration -> Control
Energy (Meters)
The AK-CS has the ability to communicate with the Wattnode +™ and Garlo Gavazzi power meters.  In addition to the power meters, 
pulse inputs can be gathered and used to register KW usage.  Once the initial definition of Energy is complete, configuration is done 
under the Energy tab.  In addition to displaying & collecting energy usage the AK-CS can use this electrical data to apply demand 
limiting.  Demand limiting is covered later in this guide.

Note: WattNode + communicates over LonWorks® FTT10 & requires a suitable network bridge.  Carlo Garvazzi EM24 meters run over Modbus, 
please note that mixing Carlo Garvazzi power meters and Danfoss EKC controllers over the Modbus network is not permitted (due to incompat-
ible bus speeds).  If Carlo Garvazzi meter is connected via Modbus network, ensure any EKC controllers are on LonWorks® network (RS485 or 
TP78).  If using EKC Modbus controllers, use pulse input method of power meter readings.

When answering the question ‘Number of Meters’ the AK-CS will make available another line that allows the definition of the meter 
type or pulse.  Use the drop down menu to define the meter type.

Define quantity of  Energy 
Meters

Select type of meter

Configuration -> Control
Leak (Gas detection)
Leak detection can be covered by using the following options, available under the leak heading. 
Leak -
HGM-
IR-F4-R -
Leak 10v -
Once the initial definition of Energy meters is complete, configuration is then done under the Energy tab.  
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Configuration -> Control
Misc (Miscellaneous sensors & inputs)
Under the Misc line, a collection of relay, sensor, on/off inputs & variable outputs can be defined.  Using miscellaneous inputs allows the 
AK-CS system to control, alarm and monitor a wide range of items that fall beyond standard refrigeration or HVAC control.
Each type of miscellaneous sensor has it’s own line, where the required number can be defined.

Once the initial definition of Miscellaneous is complete, configuration is done under the Misc tab.  

Define any Misc points 
required

[5] REFRIGERATION CONFIGURATION
Configuration -> Control -> Refrigeration
Once the central control page has been defined, detailed configuration of each control area can be done.  The next tab following 
‘Control’ is the Refrigeration tab.  The Refrigeration tab provides access to schedules, compressors, condensers, circuits & address.

SCHEDULES (used in combination with Danfoss controllers)
Configuration->Control->Refrigeration->Schedules 
Enter the number of schedules required.  The desired number of schedules will be shown (in this example 3 schedules have been 
requested).  Initially each new schedule is set to disabled, move the cursor to the required schedule line and press ‘Enter’.  The resulting 
page allows the definition of the schedule, the following configuration settings can be made;

Enable this schedule (ensure this is set to ‘YES’ to engage schedule)•	
Schedule usage (Choose from Misc, Case Lighting, Night Setback, Shutdown, Defrost, Coord Defrost)•	
Description (Add custom description for schedule)•	
Schedule control (Choose between Time, Digital, Time & Digital, Time or Digital)•	
Number of schedules (select the number of sub schedules required)•	
Start, Stop, Days and Holidays (Define the Start / Stop times, days and holidays)•	

Each schedule line will also reflect the current status
False = schedule not active

True = schedule is active
Disabled = Not Active (Enable in schedule setup page) 
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The example screen below highlights the different areas of schedule configuration, in this example the [Case Lights] schedule has been 
set to start at 04:00AM until 01:00AM based on Time [AK-CS time] or a Digital Input.  For this example the Digital Input had already been 
defined under the Miscellaneous ON/OFF section, using AK I/O input 01-1.1.  The schedule will now become true (ON) if either the 
Digital switch is made OR the Time falls between the set Start / Stop times.

The example also has active schedule days seen as -MTWRFA.  Sunday (S) has been deselected (-) therefore the schedule is only relevant 
Monday -> Saturday.  I.E.  S= Sunday, M=Monday, T=Tuesday, W=Wednesday, R=Thursday, F=Friday, A=Saturday.

After the schedule has been created the associated circuit [Evap] controllers must be selected - do this via the Controllers tab.

Note:  A start / stop time of 12:00AM - 12:00AM = always ON

Set to YES to enable scheduleUse drop down box to 
select other schedules 
or use ‘Prev’ ‘Next’ keys 
on the local key pad Press the enter key to select 

the pre-defined ON/OFF input

To associate controllers with the schedule, 
use the Controllers tab

Navigate to the Controllers tab and any configured evaporator controllers will be listed (if no controllers are listed make sure the 
appropriate controller type is set, as defined in the main control page).   Using the local keypad, navigate to the required controller and 
press enter.  This will toggle the controller ‘Selected’ or ‘Not Selected’.  Any controller set as ‘Selected’ will become part of the schedule.

Once all configuration of the schedule is complete, navigate back to the Schedules tab & select ‘Enable this schedule’ to YES 

Use the ‘Enter’ key to select or 
not select any controller(s). 
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COMPRESSOR / PACK [Using built in compressor control]
Configuration->Control->Refrigeration->Compressors
The choice of refrigeration control is configured in the Configuration->Control page, as previously described in this user guide.  Once 
the definition of refrigeration control has been set, the detailed configuration is done under the Refrigeration tab.  This example looks 
at both built in compressor control, (known as AK-CS) or Danfoss Pack control.  In the instance of AK-CS compressor control, as ques-
tions get answered in this list, further ones may appear.  This process allows the complete configuration of the compressors.

To configure compressor control (built in control logic via the AK-CS) navigate to the Compressors tab, once under this tab a Suction 
and Alarms tab will appear.  The Suction tab allows the configuration of both compressor and Danfoss Pack control.  

This first example will highlight the configuration areas for built in compressor control (seen as AK-CS option in the Configuration-
>Control page).  Following on from this example will be a description on configuring the Danfoss Pack controller options.

Use the drop down selection to pick the 
required suction 
configuration.  In  
addition use the  
Prev / Next keys on 
the local keypad Navigate & use the ‘Enter’ 

key to select any configura-
tion line.  Enter a unique 
name for the suction / 
compressor.

Continue to scroll down the 
page and press the enter 
key to add specific values / 
commissioning setpoints

Use the page down button 
to reveal any remaining 
configuration areas on the 
page

Suction Configuration
Name:  Enter a unique name for the suction group / compressor / pack controller
Target: Enter the value (target) to which the compressor will maintain (subject to capabilities of mechanical equipment)
Safety Cutout:  The gauge pressure at witch the controller will stop the compressor
Adaptive Suction Control:  
	 None:  Leave as none if no adaptive suction control required 
	 AK-CS:  Target pressure is adjusted based on discharge temperature of a single fixture - further settings will appear once this 
		  option is selected.
		  Bd-Pt: The board & point address of the fixture sensor used by the adaptive control algorithm (not shown when 
		  dynamic adaptive control is selected).
		  Temp Target: The temperature that the adaptive control algorithm will seek to maintain in the fixture.  (not shown 
		  when dynamic adaptive control is selected).
		  Range +/-:  The dead band around the temperature target.  As long as the fixture temperature remains in this range, 
		  the suction pressure target will not be modified.  (not shown when dynamic adaptive control is selected).
		  Maximum pressure float:  The max pressure that the adaptive algorithm will be allowed to cumulatively add or 
		  subtract from the suction pressure target.
		  Post defrost delay:  Number of minutes after termination of defrost during which there will be no target adjustment.  During 	
		  this time the circuit will not be used in the dynamic float (Not shown when Sensor adaptive control is selected.)
		  Allow float below target:  Determines whether or not the adaptive algorithm will be allowed to adjust suction 
		  pressure below the target if fixture temperature is above target temperature + range.
	 NA:  Not used in AK-CS
	 Sensor:  Target pressure is adjusted based on any sensor on the AK-CS I/O network - further settings will appear once this 
	 option is selected. (As described in AK-CS adaptive method)
	 Dynamic:  The AK-CS analyzes the performance of every case on the compressor circuit, and adjusts target pressure 
	 intelligently by using the case sensor that varies most from the setpoint.  Further settings will appear once this 
	 option is selected.  (As described in AK-CS adaptive method)

Example of built in [AK-CS] compressor control
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Night Setback:   Determines whether or not suction pressure will be offset according to a schedule to be specified later in setup. 
	 Pressure Differential:  Set the pressure offset
	 Setback from time: Start time for setback
	 Setback to time: End time for night setback
	 Setback days: Select days that setback will be applied
	 Setback holidays: Select the holidays which night setback will occur (holidays are configured under Configuration->Time)
Monitor Suction Temp:  (Yes / No) if Yes, a Suction header sensor is provided in the sensor configuration list.
Refig Type:  Select appropriate Refrigerant used
Oil Type:  Add custom text (for information use only)
Monitor phase loss:  If a phase loss detection system has been installed the resulting signal can in turn shutdown the compressor (if 
required).
Shutdown on OI Calc:  Shutdown the compressor based on a ON/OFF calculation.
Units:  Select appropriate units 
Compressor Size:  Enter the appropriate compressor size
No of Unloaders:  If applicable enter # of unloaders
Proof Type:  If applicable choose (None, OI (ON/OFF), CT)
Oil Control:  If applicable choose sensor input, On/Off Input.  A subsequent question allows the compressor to be locked out if oil 
failure occurs
Monitor Comp discharge Temp:  If applicable select yes
	 Stop comp on high temp:  Choose Yes / No
	 Stop comp on low temp:  Choose Yes / No
Discharge Pressure safety: If applicable select yes
	 Cutout:  Enter cutout pressure
	 Cutin:  Enter cutin pressure
Neutral Zone:  Neutral zone control acts to bring the current pressure toward target pressure more quickly the greater the difference 
between the two.
Plus Zone delay:  Time delay 
Minus Zone delay:  Time delay
Receiver:  If required
	 Surge control:
	ON /OFF control based on Drop leg temperature setpoints
	 Liquid Level sensor type:
	S ensor Input or ON/OFF input options to monitor refrigerant level

Compressor Alarms - Alarms Tab
Once the compressor configuration page has been completed, navigate to the Alarms tab.  This page allows alarm configuration for 
the configured compressor.  The options on this screen will depend on the previous choices made in the Suction tab.  

The alarm configuration seen in this page is done with regard / linked to the central Alarm Routing area of the AK-CS (Configuration-
>Alarms).  Ensure the Alarm Routing pages have been configured according to the site application.  See more details in this User Guide 
under Central Alarm Configuration.

Navigate to each applicable alarm line and press the enter key to bring up the alarm level screen.  This pop up box will allow the 
following choices;
Disabled = No alarms will activate on this point
Log Only = When an alarm occurs on this alarm point it will only register in the AK-CS alarm log - no physical alarm output
Normal =  When alarm is active the output will be sent once (alarm may get re-triggered if the stop condition is set for repeat)
Severe = When alarm is active the output will get re-sent every xx min
Critical = Same as Severe but with separate re-trigger time - when alarm is active the output will get re-sent every xx min
Delete = Removes any applied alarm settings

Note:  For alarms to correctly activate, the central alarm routing 
page must also be configured.  See Configuration-> Alarms
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Navigate & use the ‘Enter’ key to select any 
configuration line.  Pressing the Enter key will 
raise a selection box.  Choose the correct 
alarm setting and press the enter key again.

Depending the alarm type, further settings 
will be revealed.

If multiple compressors / controllers have 
been defined, use the drop down box or Prev 
/ Next keys to move to the next compressor.

Define the Alarm Action for each alarm 
output - this links with the central Alarms-
>Routing page.

Example of Alarm configuration for compressor control.

CONDENSER  
Configuration->Control->Refrigeration->Condenser
The choice of refrigeration control is configured in the Configuration->Control page, as previously described in this user guide.  If a 
condenser is chosen as part of the AK-CS compressor control, navigate to the Condenser tab to configure.
The same navigation & configuration principles apply in the Condenser & Alarm set up pages.

CIRCUITS [via AK-CS built in control]
Configuration->Control->Refrigeration->Circuits
If the section ‘AK-CS’ was made for circuit control in the Configuration->Control page, this builds the appropriate control questions 
under the Configuration->Control->Refrigeration->Circuits tab.

Define the custom name for each circuit

Navigate down the various control 
questions, to configure circuit control.  
Depending on control choices made, other 
lines will appear to complete the 
configuration

Use the Prev / Next keys to navigate to 
other circuits in the system. 
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Circuit Configuration options
The following options are available when configuring AK-CS method of circuit control;

Name:  Enter a custom description for the circuit
No case/box sensors:  (0 to 15)  The number of sensors in this fixture or circuit.
Temperature control:  None, Solenoid, EEPR
Target:  The target temperature required
Range:  The range is the amount above or below target that the actual sensor temperature is allowed to change before a control action 
is taken.
Dual temp control:  Allows the circuit to be used in two temperature ranges & creates a digital input (dual temp relay needed question) 
for changeover of temperature range.	
Type of defrost:  Various types of defrost can be chosen:  None, Hot Gas, Time Off, Air, or Electric.
	 Drip down delay:  The number of seconds that refrigeration will remain off after termination of defrost.
	 Termination type:  
	 Defrost sensor:  There is a dedicated defrost temperature sensor that will be used to terminate defrost. 
	 Disch air snsr:  The fixture discharge air sensor will be used to terminate defrost at a set temperature. 
	 On/Off Input:  An electrical switch (such as a Klixon® is wired to a digital input (on-off input) and will be used to terminate 
	 defrost.
	 None:  Defrost is terminated strictly on time.
	 Hot gas return:  Hot gas defrost is terminated when a return air sensor reaches a setpoint. 
	 Termination temp:  The defrost temperature sensor value at which defrost will terminate.
	 Use min defrost time:  Whether or not minimum defrost time will be used.
	 Minimum defrost time:  The number of minutes defrost must be on before termination.
	 Fan control:  Answer Yes if fans are to be controlled during and after defrost. If you answer No,
	 fans will run continuously during both refrigeration and defrost.
	 Fans on during defrost:  The answer determines whether or not fans will run during defrost.
	 Stop fan on high temp:  Whether or not fans are to be stopped when temperature rises above a setpoint to be specified in the 
	 next line.
	 No of defrosts per day:  The number of defrosts each day.
	 Defrost duration:  The number of minutes after which defrost will terminate, if termination has not occurred on a setting
	 configured in the previous screen. 
	 Defrost start time:  Time of day each defrost will initiate.
Antisweat control:  Whether or not anti-sweat heaters will be controlled by the AK-CS.  When you configure a circuit (evaporator)
and answer Yes to the anti-sweat control question, a relay output is created which is then wired to a relay controlling the anti-sweat
heaters. The name of the relay output will be “Antisweat” + the name of the evaporator or circuit.
	 Antisweat Control type:  Digital or Analog
	 ON when above dewpoint:   The dewpoint above which anti-sweat heaters will be on constantly. 
	 Cycle above dewpoint:  The dewpoint above which anti-sweat heaters will be cycled. Cycling will occur unless the dewpoint
	 rises above the setpoint.
	 Antisweat cycle time:  The time interval on which anti-sweat cycling is based.
	 Antisweat during defrost:  Yes / No		
Monitor box door:  Whether or not a box door switch will be monitored (appears for boxes only).
	 Shutdown when door open:  Whether or not to shut down refrigeration when the box door is open.
Generate shutdown Input:  Whether or not a digital input (on-off input) will be configured by which refrigeration can be shut down for
service.
Number of shutdown schedules:  (1-8) The number of shutdown schedules, where x represents the schedule number.
	 Sched x time on:  Enter start time     
	 Sched x time off:  Enter stop time
	 Sched x days:  Enter Days of schedule
	 Sched x holidays:  Enter holidays
Monitor leak detector:  Must be previously configured under Configuration->Control
Generate cleaning Input:  If configured the digital input can be used to stop the circuit & alarms

Circuit Alarms - Alarms Tab
The alarms for the individual circuit can be found under the Alarms tab.  
Scroll down each appropriate line and press enter to change the alarm level, the available options being the same as found in previous 
alarm tab configurations.  In addition to the alarm level, an alarm action number can be set (1-8), configure the alarm actions in the 
central alarm routing page (Configuration->Alarms).
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CIRCUITS [via Danfoss Case controllers]
Configuration->Control->Refrigeration->Circuits
If the section for circuit control in the Configuration->Control page was set to a Danfoss Case controller, all the controller parameters 
can be seen under the appropriate circuit page.  

Seen below, the different functional groups that contain all the 
controller parameters.  Consult the appropriate Danfoss Case 
controller manual for full configuration details 

Navigate & use the ‘Enter’ key to select any 
configuration line.  

Continue to scroll down the page and press 
the enter key to add specific values / commis-
sioning setpoints

Use the page down button to reveal any 
remaining configuration areas on the page

To enter a custom description for the circuit, 
navigate to the Address tab

Case controller  Alarms - Alarms Tab
The alarms for the individual circuit can be found under the Alarms tab.  
Scroll down each appropriate line and press enter to change the alarm level, the available options being the same as found in previous 
alarm tab configurations.  In addition to the alarm level, an alarm action number can be set (1-8), configure the alarm actions in the 
central alarm routing page (Configuration->Alarms).

Note:  For alarms to correctly activate, the 
central alarm routing page must also be 
configured.  See Configuration-> Alarms
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ADDRESSES [Built in AK-CS & Danfoss controllers]
Configuration->Control->Refrigeration->Addresses
After the relevant Compressors, Packs, Condenser, Circuits & Case controllers have been configured, appropriate addresses need to be 
applied.  The address inputs correspond to either the controller o03 address (Lon address) or the Board & Point address of the AK I/O 
modules.  For Danfoss refrigeration controllers the network address entered in the AK-CS must be the same as the physical device on 
the network.  In the instance of built in refrigeration control, the address relates to the I/O communication module address + the actual 
I/O input location.  See the section on ‘AK I/O’ for details on addressing AK Input/Output modules.

Controllers (Danfoss Pack & Case)
The example below shows a typical address screen for Controllers.  Navigate down the Address page to highlight the Address line.  
Enter a valid address and press the Enter key, repeating this for any other controllers seen on this page.  In the example below, 1x Pack & 
x2 Case controllers have been given an address.  Page sorting is done automatically based on the lowest address seen first.
Download:  Use this function to SEND the values / setpoints set in the configuration screens to the controller.  
Upload:  Use this function to retrieve (upload) all the parameters from the controller to populate / update the AK-CS database.  For 
both the download & upload functions a resulting time & date stamp is shown. 

Appropriate tabs for built in (AK-CS) refrigeration 
control

Enter a valid network address for the Danfoss case & 
pack controllers

Download controller configuration settings to 
device

Upload controller configuration settings to AK-CS

AK-CS Built in Refrigeration control (Using AK Input / Output)
Following from the Controllers tab, the Relay, Sensor, On/Off Inputs & Variable Outputs tabs allow the adding of the relevant I/O 
modules required for built in refrigeration control.  Each line would have been ‘built’ depending on the answers given in the various 
refrigeration setup screens (previously described).

If required, enter unique description.
Enter correct address for the Board & Point input.
Type can be changed (N-Closed / N-Open)

Ensure all tabs have been reviewed to ensure 
correct refrigeration operation.    All compressor, 

Condenser & Circuits are configured in these tabs
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Copy / Paste function
To aid the commissioning process, the AK-CS offers a settings copy / paste function which can be used to copy one device settings and 
alarm configuration to other (similar) device(s).  This function works when copying settings to and from same controller version / type 
devices.  The procedure described below is one example of the copy /paste function. 

1/ From the control screen, define the required amount suction groups, compressors, or EKC controllers
2/ Set the first controller type and leave the remaining entries as ‘none’
3/ Next navigate to the Refrigeration -> Circuits page and select the copy tab

Circuit 1a is used as the copy base and will be pasted to 
the other (selected) circuits

4/ The actual device page will act as the copy base, so 
ensure the correct circuit is highlighted

5/ Select all or individual controllers that will be 
copied to

6/ Press the copy to line

7/  The remaining devices have now been set to the 
copy base version.  All settings and alarm configura-
tion will be copied over in the AK-CS database.

8/ Use the download function to then ‘push’ these 
settings down to the required controllers 

The copy function copies controller 
parameters etc from once device to the 
AK-CS database, to complete the operation 
the (copied) settings need to be down-
loaded to the required controllers.

The Global download function can be seen 
under the Network Nodes -> Download 
section

Devices now showing copied settings
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Import (extending the functionality of generic controller parameters)
Use the ‘Import’ function to gain access to ‘generic’ controller parameters that are normally not accessible for  logging  and miscellane-
ous calculation use.  This function can be used to alarm on specific parameters not in the factory alarm list and / or can be used to 
import controller parameters in the Boolean logic calculator.  Up to thirty two controller points (combination of Sensor and On/Off) can 
be configured per generic controller.  This function extends the flexibility of controller support in the AK-CS and opens up the generic 
controllers parameter list for more customer specific needs.  The following example highlights the steps in importing a sensor input (SI) 
from a generic evap controller.

From the main menu select Configuration->Control->Refrigeration->Circuits.  Select the ‘Import’ line and press the enter key, this will 
open a dialog box which displays all the available sensor inputs from the controller.  Select the required input, which will then be shown 
against the ‘Import line #’.  This imported sensor will have a numerical identification of controller address: import number, in the 
example below the controller address is 20, hence the first import is 020:1.  A unique name can be given to this import, with the ability 
now to access and view this point from History configuration and miscellaneous calculations.

Extended configuration (changing what parameter is seen in the System View & Device detail status)
Using the extended configuration tab the factory standard parameter that is used for ‘System View’ status can be changed.  This feature is 
useful in giving the end user more flexibility in showing the relevant sensor at the system and device detail views.  By changing the 
overview value the AK-CS will then display the new selected parameter or status in the system view and device detail pages.

Select the required sensor

Select the required parameter to show in the 
system view and device detail pages.
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[6] HVAC CONFIGURATION
Configuration -> Control -> HVAC
Once the central control page has been defined, detailed configuration of each control area can be done.  The next tab following 
‘Refrigeration’ is the HVAC tab.  The following example(s) show the two main methods of HVAC control, via central (AK-CS) control and 
via Distech® EC Digital thermostat.

BUILT IN CONTROL [AK-CS & I/O]
The example below describes a typical built in (AK-CS) HVAC control method.  As seen in the Refrigeration section, the built in HVAC 
control is based around a list of control questions.  When answering these questions, the control inputs / outputs are being built and 
will be visible in the Address tab.

Navigate & use the ‘Enter’ key to select any 
configuration line.  

Continue to scroll down the page and press 
the enter key to add specific values / commis-
sioning setpoints

Use the page down button to reveal any 
remaining configuration areas on the page

Number of Zone sensors:  The number of zone sensors in the area of the store served by this HVAC unit.
Fan Type:   1-Speed:  The unit has a single-speed fan.  2-Speed:  The unit has a two-speed fan.
	 Fan control OPEN hours: Continuous:  The fan will run continuously during open hours. Store open hours are defined in the 
	C onfiguration->Time tab.  On demand:  The fan will run on demand during open hours. “On demand” means that the fan will run 
	 whenever conditions calling for heating, heat reclaim, cooling, dehumidification, or venting are met.
 	 Fan control CLOSED hours:  Continuous:  The fan will run continuously during Closed hours. Store Closed hours are defined in the 
	C onfiguration->Time tab (the closed period is from Close time to Open time).  On demand:  The fan will run on demand during 
	C losed hours. “On demand” means that the fan will run whenever conditions calling for heating, cooling, 
	 dehumidification, or venting are met.
	 Post delay:  The number of minutes that the fan will run after the last stage of heating, cooling, etc. is turned off.
	 Lockout on proof failure:  Yes: The fan will be locked out if fan proof is lost for five minutes.  Human intervention will be needed to 		
	 restart the fan by using the “Clear” button on the status screen. Evidence of the locked out condition, and the means of ending the 		
	 lockout, are found on the status screen for cooling or  heating function.   No: The fan will not be locked out on proof failure.
Monitor Phase Loss:  Whether or not a (3rd Party) phase loss monitor will be monitored.
	 Which phase loss monitor:  All available phase loss monitors are shown.
	 Shutdown on phase loss:  Whether or not the unit is to be shut down when its phase loss detector input is on.
Shutdown on digital input:  HVAC unit will shut down based on a digital input
Shutdown on smoke detection:  Whether or not the unit is to be shut down when its smoke detector is on.
Shutdown on fire alarm:  Whether or not the unit is to be shut down when a monitored fire alarm is detected.
No. of return air sensors:  (1-3)
No. of supply air sensors:  (1-3)
Cooling
	 Num of cooling stages:  (1-3) The number of cooling stages in this HVAC unit.
	 Proof:  Cooling stage will be monitored for it’s actual run status
	 Stage x (where x is either stage 1,2 or 3)
		  Target:  Enter required target temperature
		  Pre Delay:  The number of minutes that must elapse after target plus range is reached before the stage will come on. 
		  Post Delay:  The number of minutes that must elapse after target - range is reached before the stage will be turned off.
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	 Range +/- :  The range selected creates a dead band. For example, if the target is 72 and the range is 2, the stage will come on at 74, 	
		  and will not be turned off until the temperature reaches 70.
	 Ambient temp lockout:  Whether or not there is to be a lockout based on low outside ambient temperature.
 		  No Cooling below:  The ambient temperature below which cooling will be locked out. 
		  Range +/- :  The range selected creates a dead band. For example, if the lockout is 50 and the range is 2, cooling will be locked 	
		  out at 48 and will be allowed on at 52.
	 Default fan Speed:  The fan speed for cooling. A different fan speed can be chosen for dehumidification when it is configured.
	 Max suction press safety:  Lists every configured pressure sensor. Any may be selected. Only the suction pressure for the cooling 
	 compressor in this rooftop should be used.
		  No cooling above:  The pressure value of the sensor selected on the previous line at and above which cooling  will be cut out. 	
		C  ooling will not cut in again until the pressure falls below this value and the pre delay specified in the HVAC control page.
	 Freeze protection:  
		  Sensor Input:  There is a leaving air temperature for each stage of cooling, near the coil. At and below the setpoint (next line), 	
		  the cooling stage will be turned off.
	 On/Off Input:  A single digital input that when ON will turn off all stages of cooling in the RTU (Roof Top Unit)
	 None:  There is no freeze protection to configure.	
	 Night Setback:  Whether or not the cooling setpoints are to be raised by an offset (next line) during scheduled times (next page) 		
		  when cooling requirements are not as critical; for example, when the building is closed.
		  Night Setback offset:  The amount by which the cooling setpoint is to be raised when night setback schedules (next page) 		
		  are in effect. 
		  Num of schedules:  The number of cooling night setback schedules.
		  Override switch:  Whether or not there is a switch to override night setback.
		  Override duration:  The number of minutes after, activation of the override switch, that night setback will be overridden.
	 Night Setback schedules: 
		  Type:  Standard = based on start / stop times configured in following lines.  Relative = based on store schedule with offset 
		  time applied
		  Start :  Start time
		  Stop:  Stop time
		  Holidays:  Any holidays, as defined under Configuration->Time
 Heating:  
	 Auxiliary Heat type:  None:  There is no auxiliary heat.  Staging:  Auxiliary heat is staged.  Gas Valve:  Auxiliary heat is regulated by a 	
	 modulating gas valve,  Gas/Staging xxx
	S tage x
		  Target:  Heating target temperature
	 Gas Valve:
		C  ontrol from:
		S  upply Target:
		C  ontrol gain (% degree):
		I  ntegral time:
		  Min valve opening:
		  Max valve opening:
		L  ow fire position:
		L  ow fire duration:
	 Ambient heat lockout:
	 High Supply temp lockout:
		  Fan Speed:
	N ight setback:
		N  ight setback offset:
		N  um of schedules:
		O  verride switch:
	N ight setback schedules:
Dehumidification:
‘None’ or ‘cooling’ (humidity, dewpoint or calculated dewpoint, and related setpoints and delays)
Air Damper:
If set to ‘yes’ it provides pre-delay, post-delay, ambient air temperature lockout and schedule options
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HVAC control via Controller [Distech® EC Stat]
The example below describes the use of a network device  to control HVAC (seen as STAT-RTX xxx digital thermostat in the main 
Configuration->Control page).  The Distech EC-Stat range of controls are designed for single and multi-stage control of heating / cooling 
equipment such as rooftop and heat pump units.  The following instructions provide guidance on how to install an EC-Stat so that it can 
be accessed via the AK-CS.  The EC-Stat communicates over LonWorks® FTT10 protocol,  make sure correct wiring practices are used and 
install TP78 - FTT10 bridge to ensure correct communications. 
Navigate down the page of parameters to configure the relevant control settings, as per the application.

The different functional groups that contain all 
the controller parameters.  Consult the appropri-
ate Distech EC Stat manual for full configuration 
details 

Navigate & use the ‘Enter’ key to select any 
configuration line.  

Continue to scroll down the page and press 
the enter key to add specific values / commis-
sioning setpoints

Use the page down button to reveal any 
remaining configuration areas on the page

ADDRESSES [Built in AK-CS & Distech control methods]
Configuration->Control->HVAC->Addresses
After the relevant HVAC control method(s) have been configured, appropriate addresses need to be applied.  The address inputs 
correspond to either the Distech EC Stat address or the Board & Point address of the AK I/O modules.  The address of the Distech EC Stat 
must be unique to any other Danfoss controller Lon address.  In the instance of built in HVAC control, the address relates to the I/O 
communication module address + the actual I/O input location.  

The Distech EC Stat address configuration will be seen under the Controllers tab (see below).   To correctly address the controller the 
AK-CS needs to have a valid address entered and then to send this address to the controller.  In the example below, address 5 has been 
assigned to the controller, next the locate line needs to be highlighted & entered.    The AK-CS screen will display a message ‘press the 
service pin located on unit x’.  The service pin on the Distech EC Stat controller must now be set.  See the following page for more details.

Enter a valid network address

Press the locate line, the AK-CS now expects to 
see a service pin message from the EC Stat.  

Once communications have been established the 
Download / Upload lines can be used depending 
on the action required

These instructions assume the Distech EC 
Stat has been correctly installed on a 
network and is available for network scan.



AK-CS				    User Guide 

36 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

As previously described, the Distech EC Stat needs to have a valid address sent from the AK-CS, this procedure is known as ‘Locate’ and 
involves the use of a service pin activation.  To trigger the service pin in the Distech EC Stat the following procedure should be applied.

The Distech EC Stat version RT2-12 requires the ‘Yes’ & ‘No’ buttons to be pressed & held for 5-10 seconds.  Perform this procedure after 
pressing the ‘Locate’ line in the AK-CS.  After a successful locate the AK-CS will now be able to communicate and read / write to the 
controllers parameters.

	            Make sure all tabs have been reviewed to 
ensure  correct HVAC operation.    

AK-CS Built in HVAC control (Using AK Input / Output)
Following from the Controllers tab, the Relay, Sensor, On/Off Inputs & Variable Outputs tabs allow the adding of the relevant I/O 
modules required for built in HVAC.  Each line would have been ‘built’ depending on the answers given in the various HVAC setup 
screens (previously described).

If required, enter unique description.
Enter correct address for the Board & Point input.
Type can be changed according to the selections in 
the type drop down list.

EC-Stat seen with top cover off
(Select correct RT2 device in the AK-CS 

 YES  & NO buttons used 
for config service pin

New style RT2-12 Service Pin:  Press & hold the YES  & NO buttons on the 
device simultaneously, for about 5 to 10 seconds, this will broadcast the 
Neuron ID on the Lonworks network.
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HVAC Alarms - Alarms Tab
The alarms for the individual HVAC unit can be found under the Alarms tab.  
Scroll down each appropriate line and press enter to change the alarm level, the available options being the same as found in previous 
alarm tab configurations.  In addition to the alarm level, an alarm action number can be set (1-8), configure the alarm actions in the 
central alarm routing page (Configuration->Alarms).

Note:  For alarms to correctly activate, the 
central alarm routing page must also be 
configured.  See Configuration-> Alarms

Define the Alarm Action for each alarm 
output - this links with the central 
Alarms->Routing page.

Define the Alarm level (Disabled, Log 
Only, Normal, Severe, Critical, Delete.

[7] LIGHTING CONFIGURATION
Configuration -> Control -> LIGHT
The initial lighting configuration is set out under the Configuration->Control page.  The initial control question asks how many lighting 
zones are required.  The AK-CS has the ability to share any indoor photocell configured and to define how many photocells are required.  
Once these initial control questions have been completed the remaining configuration is done under the Configuration->Control-
>Light.  Lighting control is done via built in AK-CS schedules, and the optional use of photocells.  The following section describes a 
typical lighting configuration, using AK-CS control.

Detailed configuration is done under the Light 
tab (Configuration->Control->Light)

The initial Lighting configuration is done 
under the Configuration->Control page.

Danfoss recommends wiring any lighting circuits in Normally Closed position.  This will ensure that if power fails to the AK-CS 
or I/O modules the lighting systems will ‘fail safe’ ‘ON’
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AK-CS Built in LIGHTING control (Using AK Input / Output / schedules & Photocells)
The following control options can be seen in the Lighting tab, navigate and press the enter key to change / configure any relevant 
points. 

Zone Name:  Custom description (User Def) or select from a drop down list
User Defined Name:  Enter required name
Photocell:  None (no photocell), Inside photocell, Outside photocell or Skylight
Control Sensor:  Min:  The lowest-reading photocell at any given time will be used as the control sensor.  Max:  The highest-reading 
photocell at any given time will be used as the control sensor.  Average:  All photocells are averaged, and the average value is used as 
the control sensor value.  Photocell ID#1 (etc.):  If any specific photocell is selected , its value alone will be used as the control sensor 
value.
Num of Schedules:  The number of schedules for this point.
Control Method:  Schd and photo:  For this point to be on, two conditions have to be satisfied: (1) the schedule must be true; and (2) 
the photocell must be above trip level. Once those two conditions are satisfied, the pre-delay timer will start.  Schd or photo:  For this 
point to be on, either of two conditions must be satisfied: (1) the schedule must be true; or (2) the photocell must be above trip level. 
Once one of those two conditions is satisfied, the pre-delay timer will start.
Tip!  For outside lighting control via photocell, the light level needs to be below the trip level. In the case of interior lighting, turn off 
lights when we’re above a trip level.
Num of control relays:  Each zone is controlled by a relay output (digital output) on the I/O network.
Trip Level %:  The % level at which the photocell condition will be true and act to turn the lights on. (If multiple relays are configured, 
there will be one trip level per relay.)
Range: +/-:  The range selected creates a dead band.
Pre Delay:  When lights are off, the number of minutes that the lighting condition must be satisfied before lights will be turned on.
Post Delay:  When lights are on, the number of minutes that the lighting condition must be false before lights will be turned off.
Minimum on Time:  When lights are turned on, the number of minutes that they must remain on before being turned off.
Minimum off Time:  When lights are turned off, the number of minutes that they must remain off before being turned on.
Override Switch:  (Yes / No) Whether or not there is an override switch assigned to the zone.
	O verride Duration:  The duration of an override when the override switch is used.
Burglar Override:  When this zone’s lights are turned off, whether they are to be turned on when a monitored burglar alarm is sensed.
Fire Override:  When this zone’s lights are turned off, whether they are to be turned on when a monitored fire alarm is sensed. There is 
no pre-delay for fire alarms.
Enable Dimmer output:  Whether or not a dimmer variable output will be controlled.
	 Target %:  The photocell level that the controller will seek to maintain by operation of the dimmer.
	 Minimum output (0.0v):  The minimum dimmer level.
	 Maximum output (10.0v):  The maximum dimmer level.
	 Algorithm sensitivity:
	 Algorithm interval:
	 Max rate of change (% / Sec):

Tip!  Target % applies if ‘inside’ or ‘outside’ photocell used.  If a skylight photocell used, then the min output/max output (slope 
between 2 points) approach is enabled.
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Schedules:
	 Type 1: Standard (directly linked with AK-CS lighting schedule), Relative (a time that is defined before or after the scheduled start / 		
	 stop times).
	 Start1: Scheduled Start time
	 Stop 1:  Scheduled Stop time
	 Days 1:  Days of the week that will apply to this schedule
	 Holidays:  Holidays that will apply to this schedule

ADDRESSES
Configuration->Control->LIGHT->Addresses
After the relevant Lighting control questions have been configured, appropriate AK I/O addresses need to be applied.  The address 
inputs correspond to the Board & Point address of the AK I/O modules.   Depending on the control definition made in the previous 
(Configuration->Control->Light) screen various inputs will require board & point addresses.  Navigate through the Relays, Sensors, On/
Off Inputs & variable tabs to define the relevant outputs (Skip the controllers tab as all control is done via AK I/O). 

Tip!  Standard schedule (eg. on / off time 8 am to 10pm)
Relative means, relative to the open/closed hours. I.E.  Open hours are 8 am until 10 pm and a certain lighting zone needs to come on 15 
minutes prior to start of open hours until 30 minutes after closing, the schedule would look like the following; 
-0015 on  --> +0030 off   (so, being relative, the lights are on at 7:45 am and off at 10:30 pm

Navigate through the various control lines, 
enter custom description & valid address 
(Board & Point)  that reflect the location on 
the AK I/O network

ALARMS
Configuration->Control->LIGHT->Alarms
After the relevant Lighting control questions and appropriate AK I/O addresses have been applied, check the alarms tab.  Depending on 
the Lighting control configuration alarm points will be seen under the alarm tab.
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[8] MISCELLANEOUS CONFIGURATION
Configuration -> Control -> MISC
The term Miscellaneous refers to the ability to monitor and control miscellaneous areas of an application using AK I/O.  
For example, a miscellaneous relay output may be required for an exhaust fan, a dispenser that adds chemicals, an oven, a produce
fogger, or any other device that can’t or shouldn’t be treated like an ordinary refrigeration, HVAC, or lighting point.  Miscellaneous on/off,
sensor inputs can be used in defining the control strategy for miscellaneous relay outputs.  Any miscellaneous points configured can be 
monitored for history, and may be configured strictly for that purpose, or for alarms.  Routable alarms can be created for any 
miscellaneous point.  For sensor inputs, the AK-CS allows custom conversion for non-Danfoss sensors that have a linear response (known
as Conversion factors)

The initial Miscellaneous definition (quantity required) is set out in the Configuration->Control page (see blow).  In addition to Relay, 
Sensor, On/Off Inputs and variable outputs the Misc section also has Conversion Factors & Calculations.  Further details on conversion 
factors and calculations can be seen in this section.

Once the required misc points have been set, configuration is done under the Misc tab.

Detailed configuration is done under the 
Misc tab (Configuration->Control->Misc

The initial Misc configuration is done 
under the Configuration->Control page.  
Define how many Misc points are required. 

Configuration->Control->Misc
Once in the Misc screen, the following tabs are available;
Relays:  Define relay options
Sensors:  Define sensor options
On/Off Inputs:  Define On/Off inputs  
Variable Outputs:  Define variable outputs
Conversion Factors:  Define any conversion rules
Calculations:  Create boolean calculations
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Relay Tab

Depending on control require-
ments the screen layout may 
differ.

Navigate though the options, 
adding custom name, AK I/O 
address, alarms

Name:  Enter custom description for relay
Bd-Pt:  Enter a valid Board & Point address (using AK I/O modules)
Type:  Normally Closed or Normally Open
Control Input:  It is possible to use other defined points (including calculations) to act as the control Input - these will be seen in a drop 
down list
Minimum Off:  Define a min off time period to stop short cycling
Pre Delay:  Define a pre time delay before the relay activates
Minimum On:  Define a min on time period to stop short cycling
Post Delay:  Define a post time delay to minimize short cycling
Number of alarms:  Enter the amount of alarms (max 3)
Alarm 1:  Enter the alarm level (Disabled, Log only, Normal, Severe, Critical)
	 Type:  Alarm if ON, Alarm if OFF, Cycles (enter number of cycles)
	 Delay:  Enter delay time
	 Units:  Seconds, Minutes, Hours
	 From:  Defines alarm output time window
	 To:  Defines alarm output time window
	 Days:  Define the days associated with alarm
	 Action:  Define the alarm action

Example of Misc Relays Tab

If configured, navigate 
to additional relays via 
the drop down box

Relays Tab
The example below shows the Misc Relays tab.  Navigate down the control lines and configure as required.

Any Misc points configured in the AK-CS 
system will be shown in the ‘System View’ 
under the Power/Misc window
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Sensors Tab
The example below shows the Misc Sensors tab.  Navigate down the control lines and configure as required.

Sensors Tab

Depending on control require-
ments the screen layout may 
differ.

Navigate though the options, 
adding custom name, AK I/O 
address, alarms

Example of Misc Sensors Tab

Name:  Enter custom description for sensor
Bd-Pt:  Enter a valid Board & Point address (using AK I/O modules)
Type:  Select from various option in the drop down list (this example uses a PT1000 sensor)
Control Input:  It is possible to use other defined points (including calculations) to act as the control Input - these will be seen in a drop 
down list
Number of alarms:  Enter the amount of alarms (max 3)
Alarm 1:  Enter the alarm level (Disabled, Log only, Normal, Severe, Critical)
	 Type:  Alarm if above or if below limit (seen below)
	 Limit:  Enter the alarm limit	
	 Delay:  Enter delay time
	 Units:  Seconds, Minutes, Hours
	 From:  Defines alarm output time window
	 To:  Defines alarm output time window
	 Days:  Define the days associated with alarm
	 Action:  Define the alarm action
Sensor fail alarms:  Enter the alarm level to issue alarm if sensor fails (Disabled, Log only, Normal, Severe, Critical)

If configured, navigate 
to additional sensors 
via the drop down box

Configure alarm setpoints & 
actions
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On/Off Tab
The example below shows the Misc On/Off tab.  Navigate down the control lines and configure as required.

On/Off Tab

Depending on control require-
ments the screen layout may 
differ.

Navigate though the options, 
adding custom name, AK I/O 
address, alarms

Example of On/Off Inputs Tab

If configured, navigate 
to additional Inputs via 
the drop down box

Name:  Enter custom description for Input
Bd-Pt:  Enter a valid Board & Point address (using AK I/O modules)
Type:  Select from various option in the drop down list 
	 Voltage: Voltage Input
	 No Voltage:  No Voltage Input
	 Latching:  Latching Input
	 Closed: Closed Input
	 Open: Open Input
Number of alarms:  Enter the amount of alarms (max 3)
Alarm 1:  Enter the alarm level (Disabled, Log only, Normal, Severe, Critical)
	 Type:  Alarm if above or if below limit (seen below)
	 Limit:  Enter the alarm limit	
	 Delay:  Enter delay time
	 Units:  Seconds, Minutes, Hours
	 From:  Defines alarm output time window
	 To:  Defines alarm output time window
	 Days:  Define the days associated with alarm
	 Action:  Define the alarm action
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Variable Output Tab

Depending on control require-
ments the screen layout may 
differ.

Example of Variable Output Tab

If configured, 
navigate to 
additional 
Outputs via the 
drop down box

Variable outputs
Using a 0-10V water mixing valve application as an example, the following screen can be  used on the AK-CS to provide control.  The 
same principles can be applied against a wide range of control needs.  Variable output control can also be seen in certain AK-CS 
Refrigeration, HVAC and Lighting control screens.  Using the Miscellaneous area of the AK-CS a variable output point can be created.  
After authorization, navigate to the configuration->control page.  Enter the required quantity of variable outputs, remembering to also 
add a sensor input (which will be later used as a water temperature reference).   

Next, navigate to the Misc tab and scroll to the variable output tab.  Enter a descriptive name and the board & point allocation (the point 
number will be 1 to 4).  Define the working voltage range, here a 0-10 V range is set.  The previously configured sensor input (water 
temp) can be defined, along with the output % range and is used as the control reference point.
An override relay or switch can be added if required (not used in this example).  Finally an analog output failsafe can be configured.  The 
failsafe feature is to ensure safe operation during power outages, network disturbances etc.  

The following options are available;
Stay unchanged - upon failure keep output voltage unchanged•	
Maximum output - set output to 100%•	
Minimum output - set output to 0%•	
Predefined value - user set value %•	

Name:  Enter custom description for Output
Bd-Pt:  Enter a valid Board & Point address (using F4 = Akcess type).  Variable output is done via VO2 board (described opposite)
Range:  Select from various option in the drop down list: 
	 0-10, 10-0, 0-5 Volts
Control Sensor
Output 0%
Output 100%
Override type (Relay Output, On/Off)
Override point
Failsafe Type (Stay unchanged, Maximum output, Minimum output, predefined value - user definable)	
Number of alarms:  Enter the amount of alarms (max 3)
Alarm 1:  Enter the alarm level (Disabled, Log only, Normal, Severe, Critical)
	 Type:  Alarm if above or if below limit (seen below)
	 Limit:  Enter the alarm limit	
	 Delay:  Enter delay time
	 Units:  Seconds, Minutes, Hours
	 From:  Defines alarm output time window
	 To:  Defines alarm output time window
	 Days:  Define the days associated with alarm
	 Action:  Define the alarm action

Controlling sensor

In this example the sensor was 
pre-configured and labelled as 
‘water temp’

Failsafe value
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AK103A Variable Output board 
The AK-CS fully supports the family of Danfoss I/O modules.  The I/O family consists of various analog inputs, digital outputs, and relays.  
New to the I/O family is the XM103A (080Z0032) analog input /output module.  This new module offers x4 analog inputs and x4 analog 
outputs, allowing easy control of a variety of control applications.  

Terminal 9:		 12 V max 100 mA
Terminal 10:		 5 V max 25 mA

Terminal 11, 12: 

Terminal 2, 4, 6, 8:     GND-AI 1-4
Terminal 17, 19: 	  GND-AO 1+2
Terminal 21, 23: 	  GND-AO 3+4

Galvanic isolation:
AI 1-4 ≠ AO 1-2 ≠ AO 3-4
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Conversion Factor Tab

Depending on control require-
ments the screen layout may 
differ.

Example of Conversion Factors Tab

If configured, navigate 
to additional Outputs 
via the drop down 
box

Conversion Factors
Conversion factors are used for sensors that have an output range or range-to-value relationship not already defined as one of the
named “types” in the sensor input configuration list box.   The following example highlights the Conversion Factor screen.

No of conversion factors:  Enter the required amount of conversion factors
Conv 1:  Name for conversion factor (user changeable)
Units:  Select from a range of unit types: 
	 psi
	 Bar
	 °F
	 %	
	 °C
	 ppm (Parts Per million)
	 V (Volts)
	 Amp
	 Kw
	 kWh
	 Hz
	 gpm (gallons per min)
	 fps
	 pH
	 fc
	 lpm (litres per minute)
	 lps (litres per second)
	 Minimum Input:  
	 Maximum Input: 
	 Minimum output:  
	 Maximum output:
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Calculations Tab

Depending on control require-
ments the screen layout may 
differ.

Example of Calculations Tab

If configured, navigate 
to additional Outputs 
via the drop down 
box

Calculations
Conversion factors are used for sensors that have an output range or range-to-value relationship not already defined as one of the
named “types” in the sensor input configuration list box.   The following example highlights the Conversion Factor screen.
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[9] ENERGY CONFIGURATION
Configuration -> Control -> ENERGY
The AK-CS system can monitor Danfoss-approved energy meters which have a network interface.  In addition to the network meter
models, pulse inputs can be feed from a wide range of non supported meters to AK I/O pulse boards & thus basic kWh monitoring can be 
done.  Once either a supported meter or pulse input has been configured, the AK-CS can display current electrical status and log data for
history purposes.  In addition to viewing and recording electrical data, demand limiting can be performed on lighting and HVAC loads.

The AK-CS system can have a max of ten meters, only one of the meters connected to an AK-CS can be used for demand limiting.
The following section describes the configuration of Pulse and network meter types, and highlights the demand limiting function.

The Danfoss approved power meters can be seen when selecting meter type under the control question in Configuration->Control 
page and are described in the example below.

Detailed configuration is done under the Energy tab 
(Configuration->Control->Energy

The initial meter configuration is done under the 
Configuration->Control page.  Define how many 
Meters are required, then select meter type.. 

Energy meter choices:
Pulse = Output from meter fed in to AK I/O module
WN Plus= WattNode + brand meter (supplied by 
Danfoss). 

CG_EM24AV0, AV5,AV6,AV9 = Carlo Gavazzi EM24

Configuration -> Control -> ENERGY [Pulse input from meter]
From the Configuration->Control page, navigate to the Energy tab.  This example will describe the configuration of a Pulse meter type.  
Choose this ‘type’ if a non supported power meter has a pulse output that can be connected to a pulse AK I/O module (AK  XM107A).
Under the Meter Setup tab the following screen can be seen;

Meter Setup Tab.  All meter types can be seen in this 
window.  In this example, pulse meter has been 
selected.

Enter custom name for meter

See descriptions below for further details
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Name:  Enter custom description for meter
Window Size:  [Visible only when demand limiting set to yes] The window width is set to 15, 20, or 30 minutes.  Every minute, the 
window “slides” forward so that it always contains the most recent period of time.  Each minute the accumulated KW during that 
minute is recorded.
Watt-hours per pulse: Enter relevant value- Watt-hour per pulse   
Collect History:  Select yes to collect history from this meter 
Use for demand limiting:  Whether or not this meter is to be used for demand limiting.
Normal Load 01 - 24 Hrs:  Enter the upper demand limit you do not wish to exceed for the given hour of the day (defined by each hour 
line) under normal operating conditions (when using normal power).  There is one field for each hour of the day, from 01 to 24.
Maximum Emergency Load:  Enter the upper demand limit that you do not wish to exceed when the emergency generator is running.
Start Shedding at:  Enter the percent of maximum load at which you want to start shedding loads.
Start restoring at:  Enter the percent of maximum load at which you want to start restoring loads which have been shed.
Enable coupling switch:  In installations where there are two transformers and/or two emergency generators, a coupling switch can be 
used to connect both loads to one source in case the other source fails.
Number of normal steps:  The number of steps (levels) which you will allow to be shed under normal conditions.
Number of emergency steps:  The number of steps (levels) which you will allow to be shed when the emergency generator is running.
Normal:
	 Soft start begin level:  0 to the number of normal steps set above, up to 10; if 8 normal steps are configured, for example, the upper 	
	 limit of this entry is 8)  This entry specifies the level down to which loads will be turned on when the emergency generator starts. A 	
	 level will be added each minute unless the specified emergency load for shedding to start is reached.
	 Couple begin level:  [Visible when coupling switch = yes]  Emergency generator control - Enter the upper demand limit you do not 	
	 wish to exceed for the given hour of the day under normal operating conditions (when using normal power). There is one field for 		
	 each hour of the day, from 00 to 23.  This screen has two pages in order to list all the hours of the day.
Emergency:
	 Soft start begin level: [Emergency generator control]  0 to the number of emergency steps set above, up to 10;  (if 8 emergency 
steps are configured, for example, the upper limit of this entry is 8)  This entry specifies the level down to which loads will be turned on 
when the emergency generator starts. A level will be added each minute unless the specified emergency load for shedding to start is 
reached.
	 Coupling begin level:  [Emergency generator control]  Enter the upper demand limit you do not wish to exceed for the given hour 
of the day under normal operating conditions (when using normal power). There is one field for each hour of the day, from 00 to 23. This 
screen has two pages in order to list all the hours of the day.
	

Note about soft starts
The effect of a soft start is to slowly add load to the generator after it starts.  If, for instance, soft start begin level is set to 6, when the
generator starts only refrigeration loads and loads assigned level 7 through 11 will be on.  After one minute, if the load is below the “start
shedding at” percentage of maximum emergency load, level 6 will be turned on.  After another minute, the same decision will be made
for level 5, and so on down to level one.  If at any time the load reaches the “start shedding at” percentage, load shedding will begin
again until the system reaches the “start restoring at” percentage.

DEMAND LIMITING TAB (see dedicated section on Demand Limiting)



AK-CS				    User Guide 

50 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

Configuration -> Control -> ENERGY [Danfoss Supported Power meter]
As previously described, the AK-CS offers communication support to the WattNode + and Carlo Garvazzi EM24 power meters.  These 
meters offer increased parameters that can be viewed and logged in the AK-CS.  

The WattNode +® meter requires LonWorks® FTT10 interface  - Use Danfoss (part #TP78-02) TP78 to FTT10 network bridge to allow •	
correct communications . 

The Carlo Garvazzi EM24 supported meters have built in Modbus communications - connect directly to the AK-CS Modbus port.•	

Carlo Gavazzi power meter configuration (used in junction with RS485 AK-CS Model)
The following section describes the required steps to connect & configure the Carlo Garvazzi EM24xx meter over a modbus network 
connection.
Before any configuration can take place, ensure the meter is securely wired, has a valid network address (different from any other nodes 
on the ‘Controller’ network) and has a baud rate set to 9600- consult the meter manual for specific information on how to set the network 
address & baud rate.  The data format is 1 start bit, 8 data bit, no parity and 1 stop bit. 
Once set, ensure correct interconnection to the RS485 modbus port on the AK-SC255. 

(1) To avoid errors due to the signal reflections or line coupling, it is necessary to terminate the bus at the beginning and at the end 
(inserting a 120 ohm 1/2W 5% resistor between line B and A in the last instrument and in the Host interface).
(2) The network termination is necessary even in case of point-to-point connection and/or of short distances.
(3) For connections longer than 1200m a signal repeater is necessary.

Once all communication wiring has been set, perform a network scan- details of how to perform network scans can be seen in the 
Network Nodes Section of this user guide.  Ensure Modbus channel is checked in the Node Overview page.  

Enter custom name for pulse input

Enter unique Board & Point address.  This 
input address should have the pulse input 
(via the power meter) connected

Any Emergency or Coupling Switch (defined in meter 
setup) will require address configuration. 

Add these relevant address’s via the On/Off Input tab

ADDRESSES
Configuration->Control->Energy->Addresses
After the relevant Energy control questions have been configured, appropriate AK I/O addresses need to be set for the pulse meter 
input.  The address input corresponds to the Board & Point address of the AK I/O module - only use module type XM107A for pulse 
meter inputs.   Navigate to the  Addresses Tab (Demand limiting will be shown in later section).  Enter appropriate Board & Point 
location for the pulse input, under the Sensors tab (as shown below).
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Configuration -> Control -> ENERGY [Danfoss Supported Power meter]
This example highlights a Danfoss supported meter WattNode + (Danfoss part # WATTNODEP1).  The principle of configuration is similar 
to the pulse meter, with the additional requirement to locate and log the device on to the AK-CS network.

Using the drop down list, the WattNode + 
meter has been selected.

Name:  Enter custom description for meter
Amperage:  Select the amperage of the CT’s connected to the Wattnode +. 
Collect History:  Select yes to collect history from this meter 
Power Update:  Interval to which power is measured.
Energy Update:  The interval over which energy (the integral of power over time) is calculated. 
Reactive Update:  The interval over which reactive components are recalculated. 
Demand Period:  The interval over which demand is calculated. Demand is defined as average power over a specified time interval. 
Demand Subintervals:  The # of divisions of the demand period used when calculating a “rolling demand” using a “sliding window.”

ADDRESSES
Configuration->Control->Energy->Addresses
After the relevant Energy control questions have been configured, the meter must have the address correctly configured.  To add the 
WattNode + meter to the AK-CS network, ensure all network wiring is in place and that power has been applied to the WattNode + 
meter.  Navigate to the address tab and then select Controllers tab (see below),    Navigate and press enter when on the ‘Press to 
Locate’ line.  This will enable the AK-CS to ‘listen’ on the network for the meter - Press the service pin on the meter to complete scan.

Ensure the correct meter is shown in the drop down list 
(pulse meter inputs do not show up under the 
controllers tab).

Press enter key to start network search for WattNode +

After pressing the locate line a message is shown in 
the bottom of the screen.  The service pin on the 
WattNode + meter must now be pressed.
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DEMAND LIMITING

The AK-CS Demand Limiting function is based on a designated utility power meter, only one meter can be assigned Demand limiting,
even though  up to five meters can be connected to the AK-CS.  Once a meter has been selected, the Demand Limit function can be
applied against any Lighting and HVAC load.

Utility demand is monitored every minute.  Every minute, the most recent n minutes are averaged (where n is the width of the 
configured window, 15, 20, or 30 minutes defined in the meter set up window Configuration->Control->Energy).  If the average reaches
the configured “start shedding at” percentage of configured maximum demand, Step one (all lighting zones and HVAC units assigned to
level 1) will be turned off.  After one minute, when the average is calculated again, if the demand is still above the configured percentage
of configured maximum demand, level two will be shed, and so on.  When demand has dropped to the  “start restoring at” level, the last
level shed will be restored, and then the others in descending order, so that the last load restored will be the one which was shed first. 
Restoration will continue as long as the load remains below the “start shedding at” percentage.

If both normal and emergency load limits are to be established,  the relative on/off input for the automatic transfer switch must be wired
and configured.  In addition, if the site has a coupling switch, you must wire and configure an on/off input for the coupling switch.		

Priority Levels (normal conditions)
Levels are shed in ascending order: level 1, then level 2, and so on up to the highest level configured, limited by the number of steps
allowed.  Levels above the number of steps configured will not be shed unless the meter configuration is changed 
(Configuration->Control->Energy meter setup).  Since there are only up to ten steps, loads assigned level 11 will never be shed.  It is
recommended that loads which are not to be shed are left at level 11, the default value.
		
Emergency level	
The priority for shedding when the emergency generator is running.  If a load is assigned level 0 (zero) for either normal or emergency 
conditions, the load will never come on under those conditions.

Configuration->Control->Energy Demand Limiting
As previously mentioned the Demand Limiting function is applied against HVAC and Lighting loads.  This example assumes that both 
HVAC and lighting have been defined in the AK-CS and that a meter has been selected for Demand Limiting.
Navigate to the Demand Limiting tab.  The HVAC and lighting systems will be seen in this page, allowing the configuration of shed levels.

Enter the required Shed levels & Emergency 
levels for the HVAC & Lighting systems.
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LEAK (REFRIGERATION GAS DETECTION)
Configuration -> Control -> Leak
The initial configuration of gas detection is done in the central control page (Configuration->Control).  The example below shows two
detectors selected (Leak and Leak 10v).  The following selections are avaiable;

Leak:  Danfoss Leak detector
HGM:  Muli Zone Yokogawa leak detection system
IR-F4-R:  xxx
Leak 10V:  xxx

Define the leak type in the configuration-> control 
page 
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[10] CONFIGURATION - SYSTEM
Configuration -> System
From the central configuration page the System tab allows the configuration of site name, preferences and user access.  This section 
describes the various areas found under the System tab.  The system page allows the following parameters to be set;

Store Name:  Enter Unique name
Preferences:  
	 Pressure:  psi, Bar
	 Temperature:  ºF, ºC
	 Date:  MM/DD/YY, MM/DD/YYYY, DD/MM/YY, DD/MM,YYYY formats
	 Time:  12 / 24 Hour
	 Light Level:  Percentage, Footcandles
	 Language:  English, Spanish, German, Portuguese, French, Dutch, Chinese

Enter the required system preferences

Auth Levels tab
The Auth (Authorization) Levels tab allows the definition of up to 7 authorization types.  Custom authorization types can be configured 
with certain system privileges / access.  In the example below, 4 auth levels have been defined (factory setting is 3).  Level 1 (Supervisor) 
cannot have the settings changed.  To change the level of access of other auth levels, navigate to the desired line and select from the 
Authorization pop up dialog box.  As factory standard 3 levels are pre-defined (Supervisor, Service, Daily User), the service and daily 
user levels can be changed as required. 

To add/delete auth levels select the ‘Number of 
authorization types’ line (max 7 levels)
The Supervisor name can be changed but the level 
of access / privileges are factory set.

Adding new auth levels allows new users to have 
specific access to key system areas.  Once new auth 
types have been created, enter custom name and 
define level of access by selecting and pressing 
enter against the Settings line (Authorization pop 
up box will appear)
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Authorization pop up dialog box (appears 
when entering the ‘Settings’ line)

The following areas of authorization are available;

Configuration
System:  Access to the System tab
Authorization:  Access to the Authorization tab
Refrigeration:  Access to Refrigeration configuration
HVAC:  Access to HVAC configuration
Lighting:  Access to Lighting configuration
Miscellaneous:  Access to Misc configuration
Schedules:  Access to Schedule configuration
Calculations:  Access to Calculations configuration

Manual Operation (seen under Service tab in device detail page)

Refrigeration:  Allow user to perform the following operations on Danfoss case controllers ;
	 Main Switch, Defrost, Cleaning, Lights, Night Setback, Shutdown
HVAC:  Allow user to perform the following operations to Relay, Inputs & sensor overrides
Lighting:  Allow user to perform the following operations -override relay 
Miscellaneous:  Allow user to perform the following operations -override relay, sensor 
inputs 
  Alarms

Configuration:  Allow user to configure alarms
Routing:  Access to the alarm routing
Acknowledge:  Allow user to acknowledge
Clear:  Allow user to clear alarms
Log:  Allow user to set alarm level to log

Other
Main Menu:  Allow user to access main menu
Device History:  Allow user to access device history
Use Menu:  Allow access to Menu function
Use USB:  Allow use of USB flash 
Rescan Network:  Allow user to rescan network

Users tab
The User tab allows the definition of up to 20 users.  A custom name and password can be given for each user.  The appropriate level 
(defined in Auth Level tab) can be assigned to each user.  The AK-CS always maintains a single user in the system profile and this level is 
factory set to the Supervisor level.  To add users simply enter the required value in the ‘number of users’ line.  The Browser language line 
reflects what language will be displayed in the web browser upon this user logging on [via broswer access].

To remove users highlight and enter the line ‘Press to remove user’

To add users select the ‘Number of users’ and enter 
required number

Enter custom name, password and auth level for 
user.

Browser Language:  This defines the language that 
will be displayed when the user log on via the web 
browser access.
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CONFIGURATION COMMUNICATIONS
Configuration -> Comm
This page allows the configuration of modem & IP settings.  The modem connection on the AK-CS allows alarm dial out only.  Follow 
the configuration lines to setup modem & IP.
Any changes in the IP configuration will require a re-st to take effect.

Modem (Alarm dialout) configuration

Internet
	 Use DNS (Domain Name System)
	 Use DHCP (Dynamic Host Configuration Protocol)
	 Use IP address as backup:  Select yes and manually
	 enter the IP address that the AK-CS will use if DHCP
	 fails.
	 Network Timing Support (NTP):  Select yes if AK-CS 
	 sits on a network that supports the NTP protocol.

The AK-CS uses a modem adapter to ensure that the 
modem is always ready for alarm dialout.  The adaptor 
connects directly to the modem and the low voltage 
power to the modem is routed through the adaptor.

A cat5 cable is then used to connect the adaptor to the 
AK-CS modem port.

Upon alarm dial out the AK-CS sends a toggle message to 
the adapter, which re-sets the power to the modem.

Danfoss Modem adapter (part # 080Z2102)

To AK-CS modem port

Low voltage power feed 
through adapter

Modem (PSTN) line

3G Wireless routers
3G technology offers many benefits over standard dial up connections.  Utilizing a 3G connection the full range of AK-CS services can 
be used, including web browser, and RMT.  Where Internet / Intranet connection is not available, Danfoss recommends considering 3G 
as a means of offering IP connectivity.  Please consult your local Danfoss sales office with regard to 3G 
connectivity. 
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[11] CENTRAL ALARM CONFIGURATION 
Configuration -> Alarms CONNECTIONS
The various tabs under Configuration->Alarms allows for the configuration of the central AK-CS alarm management.  The first tab 
(Connections) allows for modem and /or Internet based methods of alarm transmission to be set.  The following configuration options 
can be found;

Number of network connections:  Up to 2 network (IP) alarm destinations can be defined
	 Type:  E-Mail (send alarm using e-mail)
			   Server:  Enter valid e-mail server address
			   Send to:  Define up to 3 e-mail addresses
			   Reply to:  Enter e-mail address (this must be added for the e-mail alarm to function)
			   Send abbreviated alarm message:  Select yes if e-mail is to be read on mobile device
		R  emote (send alarm in text string form using IP address)
			   Name:  Enter unique name for remote destination
			   Addresses:  Enter (IP) address for alarm receiver
		  XML (send alarm using Xml)
			   Name:  Enter unique name for remote destination
			   Addresses:  Enter (IP) address for alarm receiver
			   Date:  Enter the date format which the alarm will display
			   Lang:  Enter the language required for the alarm output

									           Time:  12 / 24 Hour time format
									           Port:  3001 (factory set for XML & Remote IP alarm
									           transmition						    
									           Init:  Enter initialization string
									           Delay:  Specifiy any delay before alarm will be 
									           transmitted
									           Schedule 1:  Enter schedule times (if required) for alarm
									           transmission
									           Schedule 2: Enter schedule times (if required) for
									           alarm transmission

Number of phone connection: 
Up to 3 modem alarm destinations can be defined
	 Name:  Enter unique name 
	 Number:  Enter alarm receiver phone number
	 Date:  Enter the date format which the alarm will 
	 display
	 Lang:  Enter the language required for the alarm
	 output
	 Baud:  Enter correct baud rate for connected modem
	 Init:  Enter initialization string
	 Time:  Enter 12 / 24 Hr format
	 Delay:  Specifiy any delay before alarm will be
	 transmitted
	 Schedule 1:  Enter schedule times (if required) for
	 alarm transmission
	 Schedule 2: Enter schedule times (if required) for
	 alarm transmission

Typical E-Mail Configuration (check network 
provider for server address details)



AK-CS				    User Guide 

58 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

Configuration -> Alarms SERVICE
Once the central alarm routing has been defined (under Alarm Routing tab) the service tab can be used to trigger test alarms and 
suspend alarm generation (for service work).

System test alarm:  Select between the following options;

Disabled = No alarms will activate on this point
Log Only = When an alarm occurs on this alarm point it will only register in the AK-CS alarm log - no physical alarm output
Normal =  When alarm is active the output will be sent once (alarm may get re-triggered if the stop condition is set for repeat)
Severe = When alarm is active the output will get re-sent every xx min
Critical = Same as Severe but with separate re-trigger time - when alarm is active the output will get re-sent every xx min 
Delete = Removes any applied alarm settings

Select Alarm Action type (defined under Alarm routing)

Auto Test:
	S cheduled:  Configure days & time for test alarm
	R epeated:  Configure interval time for test alarm 

Suspend alarms generation (suspend All alarms in the 
system from being sent):
	S et time period (min/Hrs) to stop alarms being sent

Press to clear alarm log

Press to clear alarm configuration
	T his clears (deletes) any alarm configuration on I/O.

Any relays configured for alarm output can be forced on / 
off for testing purposes.  

		R  emember to leave in Auto position after
		  testing

Configuration -> Alarms ROUTING
The following section describes the functionality, scope and implementation of the central alarm configuration and how associated 
controller points are assigned these alarm actions.  The AK-CS utilizes an Alarm Action Matrix that allows a high degree of flexibility for 
various alarm routing options. At the heart of the alarm configuration is the ‘Alarm Routing’ page, where different routing options can 
be defined, along with time delays and alarm output stop conditions. 

The central alarm action matrix allows various output options (known as alarm actions) and alarm handling configuration to be 
centrally assigned.  Once the alarm action matrix has been defined, any controller or I/O point can be given an alarm action number. 
The alarm action number corresponds to the appropriate output. (as defined in the alarm routing page).  Alarm output options include;
• 5 external (AK I/O) relay outputs
• Local AK-CS buzzer
• Local AK-CS front LED
• Internal alarm relay (Only available in TP78 AK-CS version 080Z2550 & 080Z2552)
• 3 modem dial out numbers
• 2 IP / e-mail addresses 
• Serial printer output.

The following example should be seen as a guide to configuring your AK-CS alarm logic options;
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ALARM ROUTING TAB 
To configure an alarm action, navigate to the required output line (I.E. Relay A) and press enter.  The resulting screen allows the 
configuration of the alarm actions, any pre delays, duration times and stop conditions.   The results of this configuration will be shown 
in the alarm routing page.

Custom text that better 
reflects the alarm relays 
can be entered.  
Use the ‘component 
name display’ to toggle 
between custom text & 
factory name (Relay A, 
Relay B...) 

Alarm Routing page -

Alarm Actions (1-8)
Each alarm action can have multiple relays, IP address,  etc assigned 

Delays & Stop conditions 

Set pre delay, duration and 
stop conditions (for each 
alarm output selection)

Alarm output options

Select the appropriate
‘component’ (relay..) and 
configure 

Scroll down to the bottom of 
the page to reveal the 
settings for Repeat, critical & 
severe alarms

Component Column (alarm output)

Select from the options seen in this 
column;

Relay A-E•	
Front LED•	
Buzzer•	
Int. Relay (depending on model)•	
Phone 1•	
Phone 2•	
Phone 3•	
Network 1•	
Network 2•	
Printer•	

Alarm Actions (1-8)
Up to 8 alarm actions can be defined.  Each alarm action can have multiple outputs, making 
the AK-CS alarm output options very flexible.  ‘Look down’ each alarm action number column 
and any associated outputs will be seen in the left hand column

Delay
Once an alarm action is defined the
associated time delay for the action can be
set.  This delay is in addition to any delay 
already defined in any controller (i.e. EKC) or
monitoring points (i.e. I/O) defined in the 
system.

Duration
A duration time is available when either
Time or Time/Repeat are selected as stop
conditions. The duration setting defines
the length of time the alarm output will be
active for (irrespective if the alarm is still
active or acknowledged or not)
Available in second or minute selections.  0 
Sec/Min duration will result in the alarm 
output remaining off.
Min = 0 Sec/Min
Max = 99 Sec/Min

Stop
The stop condition defines when the alarm output will stop or return to configured
position.  The following definitions apply;
Time = Stop on time (set under duration)
Ack = Stop on alarm being acknowledged
Clear = Stop when alarm clears
Time/Rep = Stop after time delay but repeat if alarm is still active
Ack/Rep = Stop after alarm is acknowledged. If alarm still
active after acknowledge repeat
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Example configuration
This example will describe the steps to configure an alarm actions.  Alarm action 1 will be defined according to the following;

Relay A•	  should trigger after a 10 second pre delay.  This relay will energize any time and will only reset when the alarm clears.
The Front LED•	  should activate (de-activate LED when alarm clears)
The Buzzer•	  should only activate during the Day (Buzzer stops when alarm is Acknowledged)
Alarm message should also be sent out via •	 e-mail 

The above alarm outputs are associated with action 1 - ‘look down’ the alarm action 1 column and the relevant outputs can be seen in 
the left of the page. 
To define the alarm output options 
navigate down the page and press enter.  This opens 
another page that allows the configuration for that 
output to be set.  In the example below Relay A and the 
Buzzer can be seen.  Follow the same process for the  
other outputs.  For e-mail output, navigate to the 
Network 1 line and press enter.  Here, set the action, 
time delay & stop conditions.  (The actual e-mail 
configuration is done in the Alarm ‘Connections’ page).

The results of the alarm output configuration can 
be seen in the central Alarm Routing page.   Follow  
this process for other actions.

Alarm Routing page

Relay A Configuration page

Buzzer Configuration page

‘Look down’ Alarm action 1 

Action settings:
Once in the actual output page, navigate through the lines 
and set the relevant Action.  Each action can have the 
following settings;

Not Selected:  No action
Enabled:  Will enable this output action (any time of day)
Day:  Enable this output during day status (based on store 
opening times (Configuration->Time)
Night:  Enable this output during night status (based on 
time outside of store opening times (Configuration->Time)

Delay, Units & Stop settings:
To complete the output configuration set the time delay, 
units & stop conditions should be set.  Stop conditions;

Time = Stop on time (set under duration)
Ack = Stop on alarm being acknowledged
Clear = Stop when alarm clears
Time/Rep = Stop after time delay but repeat if alarm is still active
Ack/Rep = Stop after alarm is acknowledged. If alarm still
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Configuration -> Alarms RELAYS
If the alarm output includes relay(s) the Relays tab should be accessed to configure the board & point address for these relays.  The 
example below shows relay A & C, with the associated (AK I/O) board & point address.  

Enter the AK I/O board & point location for the relay(s)

Select N-Open / N-Closed as required

Configuration -> Alarms SYSTEM
AK-CS system based alarm conditions should be set under the System tab.  The alarms seen in this page are factory set but can be 
changed as per site requirements.  Navigate down each line and configure (pressing the enter key) as required.  The following items can 
be seen and changed under the System tab;

I/O Network Fail:  Alarm if communications to AK I/O fails
Flash Memory fail:  Alarm if AK-CS system memory fails
Database Cleared:  Alarm if AK-CS database is cleared
File Error:  Alarm if critical files do not load / not present on AK-CS system (I.E. Device list missing)
Alarm send fail:  Alarm if any active alarms were unable to be sent out
No Dial tone:  Alarm is (using modem for alarm dial out) no dial tone is detected
Low Battery:  Alarm once on board battery drops below defined voltage level or battery jumper have not been enabled
NTP Failure:  Alarm if the network time protocol fails

Factory settings can be changed as per customer 
requirements.

Alarm level & Actions can be changed
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Configuration -> Alarms I/O COMM
If Controllers (Danfoss Evap & Pack, Power meters) and, I/O has been used in the control configuration (Lighting, HVAC, Refrigeration 
etc.), these devices can be seen under the I/O Comm tab.

The I/O Comm tab allows any offline communication alarms to be configured.  The example below shows an evaporator controller 
(address 1) with the alarm level set to ‘Normal’ & alarm action ‘1’.  These factory settings can be changed in this page.

Any AK I/O points used in the AK-CS system can be found on this page, with the associated alarm level and actions set.  The factory 
settings can be changed as required.

Calculations & Other

If any calculations have been defined in the AK-CS 
system, alarms can be associated with these.  Use 
the Calculations tab to set appropriate alarm levels 
and actions.
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[12] CENTRAL HISTORY CONFIGURATION 
Configuration -> HISTORY
The AK-CS history section allows the collection and recording of control parameters, values and status.  The central history function 
allows up to 600 ‘points’ to be configured, a point being a temperature, pressure, status, relay, etc.  The collection of history allows 
further analysis using the AK-CS or remote web browser, where a graphical representation of this data can be made.

To configure history, navigate to the Setup tab (Configuration->History).  The following setup lines are visible;
Auto Configure History:  Use this function to auto select typical points needed for logging (the AK-CS will select key points in the 
Refrigeration, HVAC, Lighting and Misc control areas.  Manual configuration can be done to override these selections or add more as 
required.
Clear History Configuration:  Use this function to clear history configuration (points selected for history & the frequency of samples)
Clear History log:  Use this function to clear stored history in the AK-CS
Start / Suspend History:  Once the relevant points have been selected for history collection (using either the Auto history, manual or a 
combination of both) press this line to Start the collection.  Press again to Stop collection
Status:  Displays the current status of history collection (Collecting or Suspended)
No of Configured datapoints:  Displays the number of configured history points (max 600)

Note:  Make sure the history collection 
function is running to ensure the collection of 
datapoints.  Use the ‘Start History’ line and 
check that the status reflects ‘Collecting’

Auto Configure History

When selecting the auto configure history function 
the AK-CS presents the option to select the history 
collection sample rate.

These can be later changed & modified

Example of setup screen

11 points have been configured & the AK-CS is collecting.

In most screens in the AK-CS quick access to the 
central history page can be done via the F4 ‘History’ 
button
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Configuration -> HISTORY
Controllers
If any controllers are configured for history collection, these can be seen in the ‘Controllers’ tab.  The example below shows a evapora-
tor controller with the various control groups accessible via a drop down menu.  Any auto history settings will be seen in these control-
ler group lists, manual configuration of any parameter can be done in this page.

Use the keypad Prev / Next keys to ‘fast 
track’ through multiple controllers

Navigate and select appropriate points for 
history collection.  A pop up selection box allows 
the choice of sample rates;
5,30 sec
1,2,10,30 mins
1 Hr

Relays, Sensors, On/Off Inputs, Variable Outputs & Other 
Depending on the defined control criteria, other points may be viewed and modified under the respective tabs.   
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[13] NETWORK CONFIGURATION 
Option 2 in the main menu (menu button on keypad) will access the Network Nodes area.  The first page in this area is the Node 
Overview, which allows the scan of Lonworks® and Modbus networks.  The following section describes the scanning process and 
review of scanned nodes.  

Ensure the appropriate network channel is selected,  
and press the ‘complete rescan’ line.  The AK-CS will 
now scan the network to identify any connected and 
addressed controller nodes.  The text on the screen 
will reflect the scan progress, after a scan the time & 
date will be shown (indicating last scan)

For SLV support, select Modbus channel

After the network scan has completed any resulting count will be seen against the Nodes Scanned on Network line - this reflects the 
number of found nodes on the scan just completed.  The corresponding line below (Nodes configured in database) reflects the 
current total of  network nodes actually configured in the AK-CS database.

The last group in this table refers to the following node types;
V02 (Variable output) board
Utility Meter (WattNode or Carlo Garvazzi)
Generic (EKC , AK CC or Distech)
AK-CM (AK- Communication Modules)
Calculations

Each node (type) has a column that reflects any configured or scanned status.

Configuration -> Network Nodes-> POINTS
The next tab from Node Overview is the points tab.  This tab relates to any AK I/O configured points - the term points relates to AK I/O 
relay, sensors, On/Off Inputs and variable outputs.  Any control questions that have required AK I/O control will be seen in these tabs.  
The purpose of these tabs is to allow the viewing of the I/O point status.  The following screens provide an example of these AK I/O 
points.

Due to baud rate incompatibility, Danfoss EKC Modbus controllers & Carlo Gavazzi power meters can 
NOT co-exist on the same Modbus network.  If EKC or SLV devices are used, the Carlo Gavazzi meter will 

not be detected on the network.  If using Carlo Gavazzi meter, ensure EKC controllers are Lon RS485



AK-CS				    User Guide 

66 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

Relays Tab
Under the relays tab any AK I/O point can be seen, the initial list will contain any relay based points used in the AK-CS control configura-
tion.  The list will show the AK I/O Board & Point (Bd-Pt) address (if set) and point name.  In addition the list will show the status and 
value of the point.

Further information & status can be found by navigating to a relevant line and entering the subsequent detail page - see below for 
example.

The Relays list will show all relay points (using AK 
I/O for control)

Highlight & enter to expand view on relevant 
point line.

The relay detail page will show more configuration 
based information, including run times, cycles and 
alarms.

Use the Prev / Next keys to scroll through the relay list 
at this level
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Sensors Tab
The next tab from Relays is the sensors tab.  The same principles apply to the sensors tab as seen in the Relay tab.  Any AK I/O point will 
be seen in the list, the example below shows refrigeration and HVAC using AK-CS control (via AK I/O).
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CONFIGURATION->NETWORK NODES-> SCAN STATUS
The scan status menu/tabs allows the user to view any scanned nodes found on the network, the following tabs are visible under the 
scan status main tab;
All Nodes:  Central list will display configured devices and points.  Only configured controllers will be visible in this list.
Controllers:  Will display controller list
I/O Boards:  Display AK Board & Point status.
Other Nodes:  List of other nodes 

Controllers - list of any controllers found on scan.  The 
‘Model’ column will show Uncfg until the device has been 
configured under configuration->control

I/O Boards - list of any scanned AK I/O boards.  Each module 
(up to 9) are shown if connected.

Navigate and enter to show more details on AK I/O board
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CONFIGURATION->NETWORK NODES-> CONFIG STATUS
The scan status menu will list all configured AK I/O and controllers.  Typically this list is used to identify the device status (online / 
offline). 

Duplicates Tab
Check this list to make sure no two devices have been assigned the same network address.  Any duplicate address will be shown in this 
list.  Correct any address issues and re-scan.

Upload Tab
The upload tab will list any controllers that have been uploaded.  The upload function can be performed in the Configuration->Control 
area (one controller at a time) or here (multiple devices with one command).  The process of an upload takes the current parameter 
settings and values from the controller(s) and loads them into the AK-CS database.  This operation ensures that the AK-CS database is 
synchronised with any pre-configured controllers  on the control network.  Any upload failure will be shown on this screen, else a time / 
date stamp will be shown

Download Tab
The download tab will list any controllers that have been processed for download (where the AK-CS sends parameter data to the 
device).  The download function can be performed individually under the Configuration->Control page or here, where multiple 
controllers can be selected for download (using one command).  The process of a download takes the AK-CS database values and 
downloads them to the selected controller(s).   Any upload failure will be shown on this screen, else a time / date stamp will be shown



AK-CS				    User Guide 

70 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

[14] CALCULATIONS
Using option 3 in the main menu will present the Calculations screen. 

Calculations or Boolean Logic can form simple or complex statements.  The ability to configure calculations in the AK-CS adds a level of 
control flexibility, where control points, sensors and boolean statements can be combined together.
Access to the calculations area can be found under the Configuration->Control-Misc->Calculations but any calculations set can also be 
accessed via the main menu (Option 3).

Example calculation screen.
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[15] FILE MANAGEMENT
Under file management, access to key AK-CS files is possible.  Three tabs can be seen under file management;

Internet Files
A list of all the files required for web browser function

Device Files
List of EDF (Extended Definition File).  These files represent the various Danfoss controllers that are supported by the AK-CS and allow 
the AK-CS to correctly communicate with controllers.  The AK-CS comes factory installed with a complete list of EDF files, to add more 
files use the RMT Tool.  Any EDF file in the list can be removed (if required) by navigating to the EDF in question, enter and select 
‘Delete’.

Device Management
The Device Management screen lists all the controllers that will be shown in the drop down selection list when configuring controllers. 
This list will be seen in the controller drop down box viewed under the Configuration->Control page.  To restrict the amount of 
controllers seen in his list, it is possible to disable any file, so that it will not be seen in the drop down list.  At any time the file can be 
enabled.  The process of disabling and enabling does not delete the original file. 

		T  o reduce the amount of controllers seen in 
the controller drop down list (seen in the Configura-
tion->Control page) disable the required files.  
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[16] AUDIT TRAIL
The Audit trail provides a level of traceability when reviewing user actions.  Using option 5 from the main menu, navigate to the Audit 
trail page.  Each new action that gets recorded will have a marker number associated.  In the example below, the last action is seen as 
entry 00040 and describes that user ‘Supervisor’ changed the AK-CC450 from Enabled to Disabled on the 9th March 2009.

The Audit trial is a rolling list of user actions, to view the recorded actions scroll down the page to view the entries.

[17] INFORMATION
The information page on the AK-CS provides information on key elements of the AK-CS system.  The following information will be 
available;
 
Mac Address:  Unique address (Media Access Control) associated with the AK-CS network interface
Software Version:  Lists current version of AK-CS software
Software Created:  Time & date 
Boot Loader:  Lists current version of Boot Loader
Website Version:  The current version of the AK-CS browser
Website Created:  Time & date 
Flash Memory Size:  The AK-CS unit requires 64MB to operate correctly & accept remote download of software

Internet
IP Address:  IP address of AK-CS
Default Gateway:  IP address of default gateway
Network Mask:  IP address of network mask

Modem Detected:  Show if modem is connected

C02.103

6.1
2.102
2009-12-14  09:48 AM
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[18] USB FLASH MEMORY (including upgrading system software)
The AK-CS can read & write to USB flash based drives*.  Upon insertion or via main menu, option 7, the USB menu window will be 
shown.  A typical example of the resulting pop up screen can be seen below, with descriptions for each option.  The menu reflects  
supported files located on the USB memory stick, and may vary from the example below.

Updating system software
Options 1 -> 3 offer system software upgrade choices. 

	O ption 1: 	T he Bootloader file can be updated via USB connection.  Bootloader version 6.1 and above must be pre-installed in 	
			   order for	 this option to be available 
	O ption 2:	T he Application software can be updated via USB connection.  Bootloader version 6.1 and above must be pre-		
			   installed in order for this option to be available 
	O ption 3:	T he new file format MAI (Master Application Image) can be updated via USB connection.  Unlike the individual 		
			   bootloader and application files, the MAI offers the advantage of combining multiple system files in one main file.  		
			E   ach MAI file contains EDF files, HTML files, Device list, Application code and Bootloader relevant to each system 		
			   software release.  Combining all the required software in one file simplifies system updating, as only one file (MAI) 		
			   need to be loaded to the AK-CS. 

			   Consult the limitations and notes table below to ensure your AK-CS supports MAI file format.

	O ption 4:	S ave database via USB
	O ption 5:	L oad database via USB
	O ption 6:	S ave report (txt file format, containing main system configuration details)

* Not all USB flash drives on the market will be supported, ‘named brand’ types are recommended.  Consult your local Danfoss office for 
further advice.
	
Updating system software can also be done via the RMT tool.  Consult the RMT section for details on remotely updating the AK-CS.

MAI file format limitations & notes

CPU cards V1.2 and above must be installed (see follwoing section on how to tell what CPC card version your AK-CS system has)
Bootloader 6.1 and above must be pre-installed

‘Hot Plug’ is not supported.   If the USB disk is connected to the AK-SC255 when the unit is booting up it (USB) will not be detected. 
Insert USB during normal run time operation or when in Bootloader mode

All software and files to be loaded must be placed on the USB root directory.   Files that are inside sub folders will not be detected

Only the highest version of the software will be available for upgrade and shown in the menu

Only compatible versions of Application & .mai files will be displayed.   When upgrading the AK-CS, only ‘same category’ code base 
will be accepted, I.E. Attempting to install AK-SC255 software on a AK-CS unit will fail.
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Updating AK-CS DIN mount units
When upgrading system software on AK-CS DIN units, two main options are available. 
1. RMT
2. USB

RMT
When using the RMT tool, the AK-CS DIN unit IP address must be known in order to make a connection.  Depending on installed 
conditions, the IP address may be known, in situations where the IP address is not known, use the rotary address switch to force a fixed 
IP address.  Rotate the address switch on the AK-CS DIN to position 9, this will assign a fixed IP address of 192.168.1.161.  Using this 
address in the RMT tool a connection can be made, and after successful log on, system software can be updated via the tools menu.  
MAI is not currently supported in the RMT, select the csi file format.

USB
Utilizing the LED lights seen on the DIN AK-CS model, it is possible to use the USB method to update system code and files.  The berg 
jumper and rotary address switch are also used in the process.  The table below reflects the LED patterns

How can I tell if my AK-CS has version 1.2 or above CPU?
To determine if version 1.2 CPU card or above is installed, refer to the product label (located on the right had side of the screen unit).
The two digits preceding the characters BJ (See figure below) must be 10 or greater.  Any digits lower than 10 will indicate that a CPU 
card version less than 1.2 is installed.  Version 1.2 CPU is required in order to use the new MAI file type

LED # LED State Selection

1,2,3,4,5,6,7,8 ON,OFF,OFF,OFF,OFF,OFF, *,* 1: Boot loader Upgrade

1,2,3,4,5,6,7,8 OFF,ON,OFF,OFF,OFF,OFF, *,* 2: App Upgrade

1,2,3,4,5,6,7,8 OFF,OFF,ON,OFF,OFF,OFF, *,* 3: MAI Upgrade

1,2,3,4,5,6,7,8 OFF,OFF,OFF,ON,OFF,OFF, *,* 4: Load Database

1,2,3,4,5,6,7,8 OFF,OFF,OFF,OFF,ON,OFF, *,* 5: Save Database

1,2,3,4,5,6,7,8 OFF,OFF,OFF,OFF,OFF,ON, *,* 6: Save Report (available only in CS)

080Z2551012510BJ188

Identifying AK-CS installed CPU card version.  In this example the digits 10 identifies a 
CPU card V1.2 or above is installed

LED patterns:
1) Incremental Running LED’s ( 1 -> 5) indicating that a USB device has been detected
2) Decrementing Running LED’s ( 5 -> 1) indicating that there is a data transfer going on between the USB disk and the AK-SC255 unit
3) When all the LED’s 1-5 are ON it indicates an error while downloading.
4) LED 1-6 Indicate a particular selection, the selection is valid only when berg pin is on
5) LED 7 & 8 blinking alternately indicates unit is in boot loader mode
6) LED 7 blinking and Led 8 ON indicates unit in application mode.
7) LED 6 blinking indicates downgrade warning (the user is trying to move from a higher application to a lower application so database 
will be deleted)
8) After a successful upgrade when the unit comes back up the unit will have LED 6 ON indicating successful upgrade
9) If LED 6 is blinking after a boot up in App mode, this indicates extraction of support files from the MAI images failed
10) If LED 8 is toggling on and off it indicates extraction of support files from the MAI during application boot up just after an MAI 
upgrade
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1

2

3

4

5

6

7

8

Power
Comm Status

1

2

3

4

5

6

7

8

Power
Comm Status

LED Incremental pattern (1 -> 5)LED Decremental pattern (5 -> 1)

Update procedure
The following steps should be followed while upgrading a AK-CS DIN unit both in the bootloader and normal run status.

1.	E nsure that the unit is either in the bootloader mode or application mode (Note the pattern on Led 7 and 8)
2.	 Also ensure that the Rotary address switch is in position zero (If the switch is at any different location ensure that it is returned to that 	
	 position after the upgrade)
3.	C onnect the USB disk to the unit
4.	E nsure that there is an incrementing running led pattern on the LEDs. If no pattern is evident, disconnect and re-connect the USB, 		
	 repeat until the LED pattern shows.
5.	R emove the berg jumper if connected.
6.	O nce the USB is detected, make a selection using the Rotary address switch, using the following assignments

	R otary Address 1 = Boot loader Upgrade
	R otary Address 2 = App Upgrade
	R otary Address 3 = MAI Upgrade
	R otary Address 4 = Load Database (Only in application mode)
	R otary Address 5 = Save Database (Only in application mode)
	R otary Address 6 = Save Report (Only in the CS version)

7.	I nsert the berg jumper.
8.	E nsure that the LED pattern on leds reflects the selection made. Refer the above table for the correct pattern. (If the Led pattern 
does not reflect the selection that mean Invalid selection was made.)
9.	C heck Led 6 if blinking the user is downgrading, ensure that you really want to downgrade
10.	If the pattern matches the selection, remove the berg jumper.
11.	Position in the Rotary address switch back to position 0. this indicates a confirmation
12.	Insert the berg jumper back
13.	The led should show a decrementing running led pattern indicating data transfer between USB and the AK-CS unit.
14.	Restore the rotary switch back to the original position before you stared the upgrade.
15.	If you made a wrong selection or the patterns do not match, Remove the berg jumper and move the rotary switch to position 9 to 
reset. Ensure that you have incrementing running led pattern and then start all over again.

After each code / application update or database load (Bootloader, Application, MAI or database)  ensure the AK-CS is re-set

Important notes

•	 Always move the rotary switch only when the berg pin is removed
•	 Position 0: Indicates confirmation to process with the operation.
•	 The LED pattern will be visible only when the berg jumper in on.
•	 The position of the rotary switch will be read only after the berg pin is inserted back 
•	 Position 9:  Can be used like ESC
•	 If the LED pattern does not match the selection there is a mistake so don’t proceed with confirmation
•	 The Incrementing running led pattern indicate the initial state of the USB Menu

	R e-set the AK-SC255 after each code loading sequence or database load•	
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[19] MESSAGES
The message area allows the input of useful information.  Two tabs are visible, Messages and Contacts.
The message tab can be used for short free text messages.
The Contacts tab allows phone and address information to be added.

For large text input, consider the use of the browser connection, where full keyboard input is possible. 

LOG OUT
Use this option to log out of the AK-CS, authorization is removed.

Example of a contacts list

Example of a message list
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[20] SYSTEM VIEW
Once all the configuration settings have been completed, the system view will reflect the control application.  The AK-CS screen will 
dynamically change as control applications are added / removed.  The system view provides an easy way to view all the control 
applications and is navigated via the arrow keys on the keypad.  

Alarm:
Any device or point in alarm, will be highlighted by a red bar

Refrigeration using pack 
control

Refrigeration using
circuit control only

Navigation:
Use the arrow keys to navigate 
through the System View 
screen.  Press enter to access 
the device detail screens

Access all alarms System View Site View 
(graphical view)

Access all history & trend logs
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[21] SITE VIEW
The AK-CS can display a custom bit map image, with system parameters mapped and displayed.  The Image should be prepared using a 
graphical process tool (Paint shop Pro...).  The custom image must conform to the follow specifications;

Colours:  240 (8 Bit)
Size: 632 x 408 Pixels (size)
Format: BMP Windows Bitmap

Once the bit map file has been created and saved it can be subsequently loaded in to the RMT tool.  See the section on RMT for detailed 
instructions on how to map system parameters, download image to AK-CS.  This (download) process will also include the loading of a 
jpeg image (of the same image) - the jpeg image is then used for browser connection.

As part of the download process, it is possible to map system parameters on the image to provide live status or readings.

Site View example - Using text 

Site View example - using text & graphics .
System parameters can be mapped on the image to show live status 

		T  he Site View adds the opportunity to 
create custom specific screens - For example a simple 
HACCP page could be created that just displays the 
current product temperatures.  
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[22] DEVICE DETAIL
From the system view select and enter any control device.  This will display the ‘device detail’ for that particular device.  The example 
below shows a refrigeration circuit.  All other device types and miscellaneous points reflect a similar screen layout and navigation 
techniques.

Access key areas of the AK-CS system via the short cut buttons

Case temp - quick view
Device detail and 
current status.

Access current status, 
settings and Manual 
operations

Access other devices 
without exiting this screen 
(via drop down list)

Controller function group

ALARMS
The AK-CS offers a central alarm page that provides access to active alarms, acknowledged alarms, cleared alarms, status and service.
All active alarms can be seen under the active tab, with details of the alarm seen in the top of the screen.  Scrolling down the active 
alarm list will update the alarm details for each entry.  To view more details navigate and enter the alarm line, a resulting dialog box will 
appear, reflecting alarm details.  
Use the Ack All and Ack. alarm buttons to acknowledge any or all alarms.  Any acknowledged alarms will be seen under the acknowl-
edge tab.  Cleared alarms will be seen under the cleared tab.  The Status tab reflects AK I/O alarm settings.
The Service screen allows access to system test alarms, suspension of alarms and the clearing of the alarm log. 

		T  o quickly navigate across a range of 
controllers, simply press the Next / Prev buttons on 
the keypad.   The next device will be shown
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HISTORY
The main history screen on the AK-CS displays up to 5 points.  To select which points are to be displayed, use the ‘Select ’ button.  This 
will present a configuration screen listing all points being collected in History.  Use the ‘Time’ button to specify which time / date to 
display.

Rate
	 Use this drop down selection box to choose the desired plot rate

View
	S napshot - Displays a fixed graph 
	L atest - Provides a rolling view of history, updated based on the rate selected
				  

Use the Prev / Next keys to move the history pointer

Measurements will be displayed and updated
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[23] WEB SERVER 
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The AK-CS has built in web browser capability and this interface can be used to view, change settings, commission and generally 
operate the AK-CS.  The AK-CS web browser is designed for easy remote access and navigation and offers the following highlights;

Commission AK-CS (full read / write)•	
View current status, alarms  and settings•	
Change settings and parameters•	
Site View (graphic) screen•	
Export History Data to .csv format•	
Access ‘On Board’ AK-CS User Guide•	
Language translation •	

The following section covers the main elements of the browser interface. 

Enter the master IP address of the AK-CS to connect

Home Screen

Log On / Off 
button & status 
icon

Main system Tabs

The browser connection can be made by typing in the AK-CS IP address.  After the initial loading page the browser will present a log in 
box, where the correct user name and password must be entered.  The Home screen will be presented and will display all configured 
datapoints.  The screen is split in four main sections (Refrigeration, HVAC, Lighting and Power/Misc), however a zoom view can be seen 
by double clicking the relevant application type bar (i.e. double click the refrigeration bar and a refrigeration only window will show.

The main areas of the AK-CS can be accessed via the main tabs seen at the top of the screen.  Click on any tab to view more system data.
From the home screen, double click any control point to view more detail (device detail screen)

Double click on 
any point to 
access the device 
detail screen. 

(Red indicates 
alarm, yellow 
signals defrost)

Application zoom ScreenAK-CS Web loading 

Site view (requires loaded Viz file)
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DEVICE DETAIL
Similar to the local screen design, the Device Detail screen in the browser shows a small history trace and associated  status.  The device 
detail page offers a quick and easy way of identifying the current status of the device or point in question.  Depending on the control 
type or point (I/O, controller, lights, HVAC, etc.), different parameters will be seen, although the same page format will be applied.  

To change device or point settings, navigate to the Settings tab.  Within the settings tab, double click any set point line to change type 
or value.

Device Detail

Drop down selection Prev / Next deviceStatus | Settings | Service tabs

Access to alarms 
(for this device) 
and History (for 
this device)

Device Detail Page- I/O sensor shown 

History- Device Detail Page- I/O sensor shown 

Alarm Detail



AK-CS				    User Guide 

84 Lit. no. USCO.EI.RF0.B3.22 / 521U0143

Expand icon.  Press the ‘+’ icon 
to expand the controller 
details.  Press the ‘-’ to return

DEVICE DETAIL (Danfoss controller)
Where a Danfoss case or Pack controller is used, more information is shown.  To better manage the viewing of multiple parameters the 
device detail page has two functions to assist.  The first function can be seen as the blue ‘+’ icon.  When clicked the lower half of the 
screen will expand to allow full view of the device parameter lists.

The second feature can be seen when clicking the Advanced View link.  The resulting window presents the controller in full page view, 
with any corresponding devices (same application type) shown in the left hand side.  Simply click any of the controllers in the left 
window to access all parameters.

Advanced View

Use the slide bar to navigate 
through the controller 
groups.  

Controller selection list
Double click setting to 
change

Device Detail - EKC view 

Advanced View  - showing EKC
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(Global) History  

History Plot

Using the select 
datapoints button, 
select the required 
trace.

Select Datapoints

Temperature 
Axis Zoom

Use the axis 
pointer to zoom 
in/out

Same principle 
for time axis

Sample Rate:
The wider the 
sample rate the 
more time will be 
displayed on the 
graph

Start Time:
Select start time of 
graph 

Start Date:
Select start date of 
graph

Refresh:
Use the refresh 
button after 
changing the 
sample / start 
options

Export History:
Export history in .
csv format

History (Global history - all devices)
To access system wide history, select the main history tab in the browser.
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Export History (.CSV format)

		  When exporting for the first time the 
browser may block the process.  Enable cookies 
from the AK-CS and repeat export process

Alarms
The (global) alarm page has four sub menus (Active Alarms, Acknowledged Alarms, Cleared Alarms, Alarm Status/Service).  
All alarms which are currently active but not yet acknowledged are viewed in the Active Alarm List.  Use the Mute/Ack button to 
acknowledge all alarms in this page or double click each alarm line to acknowledge individually.
Use the Acknowledged Alarms tab to view all alarms that have been acknowledged.
Alarms that have cleared (alarm condition has been rectified) can be seen in the Cleared Alarm list
Use the Alarm Status/Service tab to view if any alarms are still active or tripped.  The Service tab allows the testing of system alarms 
and to clear alarm logs.
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CONFIGURATION
Following the same principles described for the local screen, the web browser can be used to configure the AK-CS system.  Using the 
main Configuration tab, a sub set of tabs allow access to all configuration settings.  Using the (sub) tabs, full system commissioning and 
configuration can be accomplished.  

The flow chart below indicates a possible commissioning process for the AK-CS, when configuring for the first time.  Use this work flow 
as a guide, however each store configuration will be different.  Full attention should be given to all aspects of the commissioning 
process.

1.0

2.0

3.0

4.0

5.0

	 For the initial configuration navigate to the ‘Time’ sub tab under Configuration 
Configuration -> Time.  Set the correct time / date and time zone (i.e. GMT = 0).  Next 
define the store opening hours, these times can be reference with any (store) lighting 
schedules or relative schedules found throughout the AK-CS system.  Finally, define 
the daylight savings.

Under the Configuration -> System tab, configure the store name, and engineering 
preferences (psi, Bar, °F, °C, Date / Time format, light level and Language).  Under the 
Auth Levels tab the AK-CS comes with 3 authorization levels, add more if required & 
define the scope of  authorization under the settings line.  Once the Auth levels have 
been defined, users can be assigned against these levels - do this under the Users tab.  

Use the Comm tab to define the AK-CS IP and modem settings -reset after any 
changes

Once the basic system preferences have been setup, configure the central alarm page 
(see ‘Central Alarm configuration’ for explanation).  Navigate to Configuration -> 
Alarms and select the Alarm Routing tab.  Configure the alarm actions and compo-
nent outputs according to your application

	 If network nodes (Danfoss controllers, AK I/O, etc) are already connected and 
addressed a network scan can be sent to identify the nodes.  Navigate to the Configu-
ration -> Network Nodes (Node Overview tab) and select the correct Channel type.  
Double click the ‘Press for complete rescan’ line to initiate a network scan.  After scan 
has completed view details under the Scan Status tab (Configuration->Network 
Nodes->Scan Status).  If appropriate, the network scan can be performed at any time.

	 Define the application layout by navigating to the Configuration -> Control page.  
Go through the control options listed on the page, noting that any control type listed 
as ‘AK-CS’ refers to built-in control via AK I/O.  Once the applications are defined, 
navigate through each (applicable) application to configure.  For example, if the 
control choice for compressor control was AK-CS, select the Refrigeration tab and 
then the Compressor tab.  The Address tab holds the address numbers for AK I/O & 
Controllers - ensure all address information has been filled in correctly.  Use copy / 
paste function if required.

!  If configuring the AK-CS on an existing network of Danfoss controllers, perform a 
global Upload (found in the network nodes screen) to ensure the controllers on the 

network populate the AK-CS database with their current values/settings. 

	 Once all controllers, AK I/O have been correctly configured and scanned, start the 
history logging by navigating to Configuration -> History.   Double click on the ‘Auto 
Configure History’ line to prepare the history collection and select the required 
sample frequency.  Double click the Start History line, the status should be reflected 
by displaying ‘Collecting’.  To ‘fine tune’ any sample rates, select the appropriate 
control device and change the frequency to the required rate.

	 Upon completion of the commissioning process ensure the database is saved.  This 
can be done by using the RMT (see section on RMT for more details) or via the USB.  
Inserting a supported USB flash drive will issue a promt on the local screen.  Select 
option 2 (Save Database)
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Enter the master IP address of the AK-CS to connect

Navigation trail

Configuration Page

1.0

2.0 Perform network scan

3.0 Define & Configure the control applications

4.0

Configure History

Example - Configuration->Alarms ->Alarm Routing 

Double click 
component to 
configure alarm 
output settings
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Configuration-> Network Nodes (Scan for network nodes)

Network Type

Lonworks®
Modbus 

Double click to 
initiate scan

Configuration->System (Authorization Levels) 

To add more auth levels double click the ‘Number of authorization types’ line

Double click the Settings line to define the scope of authorization - 
use the check box to select areas of the system to which this level 
can access
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Control

Select the required 
control applications

AK-CS =
Built in control 
via AK I/O

Once the control applications have been defined, 
click on the relevant tab to commission in detail

Example - Define the control applications (Configuration->Control Page)

Example - Configuration->Control Refrigeration -> Circuit (evap)  

Drop down list

If multiple devices are 
configured, use the 
drop down box to 
select appropriate 
device 

Controller function slide bar

When accessing controllers 
with multiple function groups, 
use the slide bar to navigate

Alarms tab
Configure alarm actions 
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Example - History Configuration

Example - History Configuration - fine tune parameters

For easy & fast history collection use the Auto Configure History function.
Select the appropriate collection frequency, this will be applied across all auto configured points.  
Fine tuning can be made to this frequency rate (see example below)

Start collection

		R  emember to start history collection

To ‘fine tune’ (alter collection frequency, add more samples not covered by the Auto Config function) any parameter use the relative 
tabs to locate the required parameter.  For example, the screen below shows a circuit controller (Controllers tab) with the parameter 017 
being turned on and collecting at a frequency of 1min samples.  Follow this principle for relay, sensor, on/off inputs and variable inputs. 
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AK-CS Info

INFO 
Under the Info tab, the following items are available;

Information:  AK-CS IP address, Software versions
Audit Trail: Entries in the Audit trail (user actions & changes)
Calculations: View any current calculations
File Management: View web & controller files required for
Translator: Translate the web text 
Messages:  Engineering notes, contractor address, contact numbers etc
Download Report:  Creates a report that highlights the system configuration
Help Manual:  Condensed version of the AK-CS user guide
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Use the Translator tool to convert English text seen in the web browser to the desired local language.  Select the required language 
and go through the list of items, then save to server (AK-CS).  A ‘live’ connection to the AK-CS must be in place for the translation to 
function correctly.

1/ Select the required language

3/ Save to server

2/ Translate text
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NOTES

Glossary of terms

RMT			R   emote Management Tool
Viz				   Visual file.  Used in the RMT tool and sent  to the AK-CS for graphic Site View
System View		C  entral page of AK-CS that displays all configured control points
Site View			C  ustom graphic page with mapped system parameters
AK I/O:			   Danfoss AK Input / Output modules
Bd-Pt:			   Board & Point address location
Alarm Levels:		  Disabled = no alarm action
				L    og Only = logs alarm in database - no external action
				N    ormal = Activate alarm output (once)
				S    evere = Activate alarm output (repeat based on severe repeat time)
				C    ritical = Activate alarm output (repeat based on critical repeat time)
MAI			   Master Application Image
CSI				C   ompressed Software Image
IP				I    nternet Protocol
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SUPPORTED CONTROLLERS IN VC02_103

Model      Part #                Software Revision Notes

Evaporator controllers

EKC 201 084B7505         V2.0x

EKC 201 084B7508         V2.0x

EKC 201 084B7510         V2.0x

EKC 201 084B7512         V2.0x

EKC 201C 084B7068         V1.2x

EKC 202A 084B8521          V1.2x

EKC 202A 084B8531          V1.2x

EKC 202B 084B8522          V1.2x

EKC 202B 084B8532          V1.2x

EKC 202C 084B8523          V1.1x, 1.2x

EKC 202C 084B8533          V1.2x

EKC 202D 084B8536          V2.0x

EKC 202D1 084B8554          V1.3, 1.4 Epta controller

EKC 204A 084B8520          V1.9x, 2.0x 1.9x has 9 app selections, 2.0x has 10 application selections

EKC 204A1 084B8534          V2.0x 10 application .edf files (A-J)

EKC 204A2 084B8535          V2.0x 10 application .edf files (A-J)

EKC 204A2 084B8524          V2.0x 10 application .edf files (A-J)

EKC 301 084B7514          V2.0x

EKC 301 084B7515          V2.0x

EKC 301 084B7516          V2.0x

EKC 301 084B7518          V2.0x

EKC 315A 084B7086          V1.3x

EKC 316A 084B7088          V1.2x

EKC 414A 084B8002          V1.1x

EKC 414A1 084B8011          V1.0x

EKC 414C1 084B8010          V1.2x, V1.3x

AK CC530 (EKC 531D1) 084B8007          V1.2x, V1.3x Split into 4 EDF files supporting multi app function i.e 84B80071.
edf (app o61=1),  84B80072.edf (app o61 = 2).....

AK-CC 450 084B8022          V1.3x 7 application selections to support multi app functions- A-G)
(i.e 84B8022.edf (app o61=1),  84B8022.edf (app o61 = 2).....

AK-CC 450 084B8023         V1.3x 7 application selections to support multi app function s- A-G)
(i.e 84B8022.edf (app o61=1),  84B8022.edf (app o61 = 2).....
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AK-CC 550 084B8020         V1.2x 10 application selections to support multi app function s- A-J)
(i.e 84B8020.edf (app o61=1),  84B8020.edf (app o61 = 2).....

AK-CC550 084B8021         V1.2x 10 application selections to support multi app function s- A-J)
(i.e 84B8020.edf (app o61=1),  84B8020.edf (app o61 = 2).....

AK-CC 550 084B8024         V1.2x 10 application selections to support multi app function s- A-J)
(i.e 84B8024.edf (app o61=1),  84B8024.edf (app o61 = 2).....
Anytek screw connections

Pack controller

EKC 531B 084B8004         V1.2x

EKC 331T 084B7105         V1.1x

SLV Variable Speed Compressors

SLV230-4321 105N4321        V1.2x Modbus SLV compressor

SLV230-4325 105N4325        V1.2x Modbus SLV compressor

SLV230-4327 105N4327        V1.2x Modbus SLV compressor

2nd Party devices

Carlo Gavazzi EM24-AV0, EM24-AV5, EM24-AV6, 
EM24-AV9 edf

Modbus Power meter 

Distech - Stat - RTX-12 DT0012x           V003x HVAC EC Stat RTX-12
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